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Where to Find 
Information

You can find information on Enhanced CU-SeeMe in this hard copy 

guide, online manuals, and online help specific to your platform. You 

can also check the White Pine Software Web pages

(http://www.cu-seeme.com) for more information on Enhanced 

CU-SeeMe, including product updates and technical support.

Enhanced CU-SeeMe User Guide
This guide provides an introduction to videoconferencing and Enhanced 

CU-SeeMe, installation instructions, and an overview of some typical 

tasks you may perform while using Enhanced CU-SeeMe. It also 

provides troubleshooting information, including frequently asked 

questions about Enhanced CU-SeeMe.

Windows® and Macintosh® Information

This user guide contains information for using Enhanced CU-SeeMe 

Version 2.1 with the Microsoft® Windows® operating system and 

Enhanced CU-SeeMe Version 2.0 on the Mac™ OS operating system. 

Most of the features of these two versions are the same. Chapter 5 

contains information on features that are new for Version 2.1 for 

Windows. 

Some pictures in this guide show Windows dialog boxes and windows. 

Others show Macintosh dialog boxes and windows. In most cases, 

Enhanced CU-SeeMe will operate identically on these two platforms. 

When the two are substantially different, both versions of a dialog box 

or window appear.

Although Enhanced CU-SeeMe works on Windows Version 3.x, 

Windows NT, and Windows 95, this user guide shows Windows 95 

pictures to represent all versions of the Microsoft Windows operating 

system. 
E n h a n c e d  C U - S e e M e
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Conventions

You will find the following conventions throughout this guide:

Online Help
Online Help is an integral part of this product. Help appears in a format 

native to the platform on which you are running Enhanced CU-SeeMe:

◆ Windows - Online help is available in the standard Windows Help 

format. To access help, choose Contents from the Help menu. 

Context sensitive help is also available by clicking the Help button 

in the dialog boxes or selecting an object and then pressing the F1 

key. 

◆ Macintosh - Online help is available in the standard Apple® Guide 

format. To access help, choose Enhanced CU-SeeMe Help from the 

Guide menu. Context sensitive help is also available through Help 

buttons in dialog boxes and through Balloon Help. To access 

Balloon Help, choose Show Balloons from the Guide menu.

This Represents

italic 
Words that are defined in the glossary at the 
back of this user guide. Each glossary term is 
italicized the first time it appears in this guide.

Information that relates to the Windows 3.x, 
Windows NT™, or Windows 95 platforms.

Information that relates to the Macintosh 
platform only.

TM

TM
ix
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Online Manuals
When you perform a Typical Install (Windows) or an Easy Install 

(Macintosh), or you select online manuals during a Custom Install, 

Enhanced CU-SeeMe creates the following folders:

◆ Manuals folder containing manuals in the Adobe® Portable 

Document Format (referred to as pdf files)

◆ Adobe Acrobat® folder containing the Acrobat Reader application 

required to view the online manuals

The following manuals are available online:

◆ PPP - The PPP.pdf file contains instructions on how to set up White 

Pine PPP™ for use with Enhanced CU-SeeMe.

◆ WhitePineBoard™ - The WhitePineBoard documentation 

(WPBoard.pdf) contains detailed instructions on using the 

WhitePineBoard. For a brief introduction to the WhitePineBoard, 

see “Using the WhitePineBoard” in Chapter 4.
E n h a n c e d  C U - S e e M e
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What You 
Should Know 
Before Using 
Enhanced 
CU-SeeMe

The freeware version of CU-SeeMe™ from Cornell University has 

developed a great following of users that are Internet savvy. You may be 

one of those followers, or a user getting acquainted with the world of 

videoconferencing on the internet.

Either way, this manual will help ensure that you have the correct 

equipment to install and run Enhanced CU-SeeMe from White Pine 

Software. Enhanced CU-SeeMe also requires a computer, a camera for 

full videoconferencing, and in some cases, a modem and a video capture 

board. This manual does not provide information on how to use this 

equipment. If you are having any difficulties with this equipment, be 

sure to refer to the manufacturer’s documentation.
xi
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Other Sources 
of Information

For information on Microsoft® Windows™, consult the Windows user 

guide provided with your version of Windows from Microsoft, Inc. For 

information on using Macintosh features, see the Macintosh System 

Software User’s Guide from Apple Computer, Inc.

Enhanced CU-SeeMe by Robert Rustici is published by MIS:Press, 

ISBN 1-55828-490-7. This book explains the nuts and bolts and 

etiquette of running a videoconference with Enhanced CU-SeeMe.

The Internet TV with CU-SeeMe by Michael Sattler is published by 

SAMS/Macmillian, ISBN 1-57521-006-1. This book provides an 

in-depth look at the freeware version of CU-SeeMe.

Videoconferencing: The Whole Picture by Toby Trowt-Bayard is 

published by Flatiron Press, ISBN 0-936648-48-1. This book, a 

videoconferencing systems and network buyers guide, thoroughly 

describes all aspects of videoconferencing.

In addition to books and manuals, the World Wide Web (WWW) 

provides a wealth of information on videoconferencing. Check out some 

of these Web sites:

◆ For the latest news from White Pine Software about Enhanced 

CU-SeeMe, White Pine Software, and other White Pine products, 

see:

http://www.cu-seeme.com

◆ In addition to writing books, Michael Sattler also maintains a list of 

reflectors available for public use:

http://www.indstate.edu/msattler/sci-tech/comp/CU-SeeMe/

index.html

◆ To visit the Cornell University web site, see:

http://cu-seeme.cornell.edu

To search the World Wide Web for sites related to video conferencing or 

CU-SeeMe, use a browser search tool, such as WebCrawler™ at 

http://www.webcrawler.com, or a search tool, such as Yahoo!™ 

at http://www.yahoo.com. When searching, use keywords such as 

cu-seeme, reflectors, or videoconferencing.
E n h a n c e d  C U - S e e M e
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An Introduction to 
Videoconferencing
 and Enhanced 
CU-SeeMe

It used to be that communicating face-to-face over a telephone or 

computer was thought of as science fiction. Then, over a decade ago, 

videoconferencing became a reality, but only for large corporations that 

could afford to spend thousands of dollars on hardware and dedicate an 

entire room to videoconferencing equipment. Recently, 

videoconferencing became available on personal computers, but there 

was still a significant expense involved because of the extra network 

connections and other hardware required to handle the communications. 

Enhanced CU-SeeMe further simplifies videoconferencing by allowing 

you to use the Internet to connect to the world of videoconferencing 

using your personal computer. 

What is Videoconferencing?
Videoconferencing allows people in different locations to communicate 

with each other not only by talking, but also by seeing each other. 

With its low-cost Internet solution, Enhanced CU-SeeMe brings 

videoconferencing into the realm of personal use. Just think, instead of 

calling a friend or relative and imagining what they look like, you can 

actually see them!

Companies are facing new challenges to stay competitive and respond to 

customer requirements immediately. To meet these demands, companies 

are constructing collaborative environments where videoconferencing 

plays a key role. Teams can work more effectively when they can easily 

communicate with each other. Using WhitePineBoard technology, they 

even have the ability to share written drawings and ideas across town or 

across continents, just as if they were sitting at a table together. This 

kind of communication drastically cuts travel expenses, saving 

companies millions of dollars, as well as time and energy. 
E n h a n c e d  C U - S e e M e
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The History Behind CU-SeeMe
CU-SeeMe started in July 1992 as a research project led by Cornell 

University in partnership with many universities, as well as with 

non-profit and private organizations. Through the efforts of these 

groups, Cornell developed CU-SeeMe into a tool that provides 

videoconferencing using video, audio, and typed text across IP-based 

local area networks (LANS) and wide area networks (WANS) as well as 

over the Internet. As part of ongoing research efforts, Cornell provides 

freeware versions of CU-SeeMe which can be downloaded from the 

Internet.

In May 1995, Cornell Research Foundation selected White Pine 

Software as the master licensee of Cornell’s CU-SeeMe desktop 

videoconferencing technology. Under this exclusive agreement, White 

Pine Software and Cornell University researchers have joined forces to 

make this low-cost, commercially enhanced version of CU-SeeMe 

available to Internet users world wide. Enhanced CU-SeeMe will help to 

make video communications part of everyday life.

Enhanced CU-SeeMe Features
Enhanced CU-SeeMe offers many features to make videoconferencing 

easy to use and to help you achieve professional videoconferencing 

results:

◆ Color - Using a high-quality, low bandwidth encoding method.

◆ WhitePineBoard - For written, as well as graphical collaboration 

during conferences.

◆ Web Browser Support - For launching Enhanced CU-SeeMe from 

any Internet Web page.

◆ PhoneBook - To manage your personal collection of conference 

addresses and for direct-dialing your favorite conferences.

◆ Listener - To alert you of incoming calls, giving you the option of 

accepting or rejecting incoming calls.
1-3
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◆ Conference Management - Using the Participants List you can 

manage Viewers, whether they are visible, hidden, or lurkers. 

Controls allow you to single out individuals for a conversation, turn 

group microphone and speakers on and off, and easily identify the 

current speaker.

◆ Video Controls - To easily find out the status of your connection, 

configure transmission and reception settings, and to set the 

brightness and contrast for your local video window.

◆ Audio Controls - To adjust the volume, turn on and off the speaker 

and microphone, and to select either voice activated 

communications or a push-to-talk option.

◆ Win32® Native (Windows only) - The 32-bit version of Enhanced 

CU-SeeMe will take advantage of the full capabilities of 

Windows 95 and Windows NT®.

◆ Optimized for Low Bandwidth Environments - Allows you to 

videoconference over a low bandwidth connection, such as a 28.8k 

modem.

◆ Fully Compatible with Cornell’s Freeware Version of CU-SeeMe - 

You can videoconference with thousands of existing CU-SeeMe 

users.

◆ Text-Based Chat Facility - For exchanging typed messages with 

other users.

◆ Easy-to-Use Preference Settings - To easily change your personal 

preferences for video, audio, and more.

◆ Easy-to-Use Online Help and Context-Sensitive Help - To provide 

helpful information on using Enhanced CU-SeeMe.
E n h a n c e d  C U - S e e M e
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Understanding 
Data 
Transmission

When videoconferencing with Enhanced CU-SeeMe, several types of 

information will be transmitted across your LAN, WAN, telephone 

lines, or Internet connection. This information includes video, audio, 

and text/graphic data. To use Enhanced CU-SeeMe most efficiently, it 

may help to understand more about this data and how it is transmitted 

over these lines.

Data Compression
In uncompressed form, video and audio stored on a computer require 

large amounts of memory. Transmitting uncompressed video and/or 

audio information is impractical given the capabilities of today’s LANs, 

WANs, phone lines, and Internet. The size of audio and video data in 

uncompressed form would be too large to feasibly transmit through a 

phone line or an Ethernet line.

To reduce the size of the information, data is compressed using a codec 

(COmpressor/DECompressor). Expensive desktop videoconferencing 

systems use hardware codecs. Enhanced CU-SeeMe uses software 

codecs for video and audio.

Enhanced CU-SeeMe’s default video and audio codecs provide for 

acceptable transmission over a 28.8k modem. If your environment 

provides for higher transmission rates than 28.8k, you may want to 

change the default settings. For more information on changing codecs, 

see “Managing Your Connection” in Chapter 3.

Videoconference Data Types
Using Enhanced CU-SeeMe, you can conference using any combination 

of video, audio, text, and graphics. Video, audio, and graphics generate 

more data than text. The amount of data you are sending must not be 

greater than the bandwidth available on your network connection. For 

example, a LAN environment in an office will be able to support 

multiple video windows and audio, while a remote connection at home 

over a 28.8k modem may only be able to support one video window 

with audio. 

Tip:

k and kbps means 
1024 bits per 
second.   For 
example, if you have 
a 28.8k modem, and 
you are using a 16k 
audio codec, you will 
have 12.8k of 
bandwidth left for 
video transmission.
1-5
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Communication Channels
It is helpful to understand how data is transmitted between conference 

participants. The size of the data varies depending on the data type (such 

as video, audio, text, or graphics). The speed at which that data is sent 

depends on the communication channel selected. Some examples of 

communication channels include a modem, ISDN, or Ethernet 

connection. 

If you think of a communication channel as a pipe carrying data 

between locations, a modem would be the smallest pipe, ISDN the next 

larger size, and Ethernet would be an even larger pipe. A larger pipe will 

carry larger amounts of data.

Enhanced CU-SeeMe provides videoconferencing over a 28.8k modem 

as a minimum configuration (and audio-only conferencing over a 14.4k 

modem). You can achieve better results using a communication channel 

that provides more bandwidth. 

You can configure Enhanced CU-SeeMe for your network environment. 

For example, Enhanced CU-SeeMe offers the ability to freeze video. If 

you have a communication channel that doesn’t allow for video and 

audio communications, you can freeze the video and only communicate 

with audio or text.

The number of windows you have open for a particular conference also 

affects the bandwidth because as you open more windows, more data 

needs to be communicated. If you are making a connection to only one 

person (a point-to-point connection), there won’t be much data to 

transfer between the two locations. Participating in a group conference 

requires more bandwidth, since Enhanced CU-SeeMe lets you open as 

many as eight windows at a time.

Basically, the more bandwidth you have, the more video, audio, text, 

and graphics you’ll receive. “Managing Your Connection” in Chapter 3 

describes the various ways you can adjust Enhanced CU-SeeMe to get 

the most out of your available bandwidth.

A larger pipe will carry
larger amounts of data.
E n h a n c e d  C U - S e e M e
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Understanding 
Enhanced 
CU-SeeMe 
Conference 
Types

Using Enhanced CU-SeeMe, you can participate in any of several types 

of conferences: person-to-person, group, or one way conferencing. 

These terms are introduced in the descriptions of the conference types 

that follow.

This section also introduces the concept of a reflector. A reflector is a 

UNIX® or Windows-based application which allows Enhanced 

CU-SeeMe users to have group conferences, or to broadcast events, 

much like TV stations do. The reflector accepts multiple CU-SeeMe 

connections and reflects the video, audio, text, and graphics to all other 

participants connected to the reflector.

Point-to-Point Conference
Point-to-point (or person-to-person) is the simplest form of 

videoconferencing, where one person conferences directly with another 

person. The two computers, both running Enhanced CU-SeeMe, can be 

connected over a modem, a private network, or the Internet. This is 

illustrated in Figure 1-1. 

Figure 1-1. Example of a Point-to-Point Conference

As an example, suppose you want to videoconference directly with a 

friend. You would need to know that friend’s IP address. You can then 

use Enhanced CU-SeeMe to call that IP address and conference with 

your friend, much like you would dial your friend’s phone number if 

you wanted to connect for a telephone call. 

▲▲
1-7
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Group Conference
Group conferencing (or many-to-many) provides a collaborative 

environment where co-workers, students, or whole families can 

participate in a conference. This is illustrated in Figure 1-2. To 

participate in a group conference, you must connect to a computer 

running reflector software. Any video, audio, text, or graphics that you 

transmit is received by the reflector, then transmitted to all others 

connected to the reflector or conference. The reflector has an IP address 

or host name that you enter to connect to it. Reflectors may require a 

unique conference id and/or password to join the conference.

Figure 1-2.  Example of a Group Conference

▲▲ ▲▲

▲

▲
▲

▲

▲

▲
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One-way (or broadcast) conferencing is similar to television 

broadcasting. This is illustrated in Figure 1-3. One computer, running 

reflector software, transmits audio and video to connected users. Other 

users can not transmit video, audio, text, or graphics; they can only 

receive broadcast data. Some examples of one-way conferencing are 

Internet radio stations that broadcast audio, NASA-TV that broadcasts 

video and audio about space shuttle missions, and trade shows that 

broadcast video and audio of keynote speakers.

Figure 1-3. Example of a One-Way Conference

➝
➝

➝

➝

➝
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 Becoming a 
Good Network 
Citizen

While using this manual or the online help, you will find sections that 

discuss network etiquette, or netiquette. Pay close attention to this 

information. These areas may give you hints on how to reduce 

bandwidth use, therefore getting better performance for yourself and 

other network users. If, however, you choose not to follow these hints, 

you may annoy other participants and you may not be allowed to 

connect to certain reflectors!

One of the easiest ways to become a good network citizen is to 

disconnect yourself from a reflector while you are out of your office for 

an extended period of time or when you are not using it. Other good 

network behaviors are discussed in the following sections. 

Setting Transmission Rates
Transmission rates are set in the Preferences dialog box (see “Setting 

Transmission and Reception Rates” in Chapter 3). The default 

maximum transmission rate is 80 kbps; however, if you are transmitting 

with a 28.8k modem, you will be limited to a transmission rate of 

28 kbps.

You may be tempted to increase your transmission rate for better 

performance, especially when bandwidth isn’t a problem. White Pine 

Software recommends only doing so for point-to-point connections. If 

you increase your transmission rate for reflector sessions (one-way or 

group conferencing), you will be using more than your share of reflector 

resources, slowing down reflector response time. To prevent this, some 

reflectors won’t allow you to connect if you are transmitting at more 

than 80 kbps. 

Sending Empty Video
Broadcasting the contents of an empty office or work area is not good 

network behavior since some reflectors have limits on the number of 

connected users. By sending video of your empty office, you may be 

preventing others from using the reflector.
E n h a n c e d  C U - S e e M e
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Leaving Enhanced CU-SeeMe Running
Leaving your computer with live video windows running consumes 

network bandwidth. To be a good network citizen, you should close all 

visible windows when you are not using Enhanced CU-SeeMe for an 

extended period of time.

Tip:

Choose Hide All from
the Windows menu 
to close all video 
windows
1-11
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 Where Can You 
Connect?

An Internet community of CU-SeeMe users has evolved, growing with 

each new release of CU-SeeMe freeware from Cornell University and 

Enhanced CU-SeeMe from White Pine Software. People have found 

exciting uses for CU-SeeMe including broadcasting the Global School 

Network, NASA-TV, and various concerts. Some places you may want 

to connect to are:

◆ White Pine Software - 199.94.217.135

◆ Cornell University - 132.236.91.204

◆ Utopia - 137.130.65.31

◆ InterNet Cafe/Nantucket - 204.249.164.2

◆ EDEN - 199.171.21.1

◆ NASA TV - 139.88.27.43

Periodically, White Pine Software sponsors events for organizations 

interested in videoconferencing. For example, White Pine has sponsored 

an ABC World News/Global School House event. ABC World News 

Now is the first regularly scheduled newscast on the Internet. From 2:00 

AM to 4:00 AM Eastern Standard Time, you can view the overnight 

news program by connecting to the following IP addresses: 

192.215.2.250 for the U.S. Reflector, and 158.36.33.3 in Europe. This is 

an ongoing project so you should refer to the ABC World News Now 

web pages at http://www.gsn.org/gsn/event.abcwnn.html 

for the latest information. You can also check the White Pine Software 

web pages at http://www.cu-seeme.com for other events.

Note:

These IP address 
numbers were 
current when this 
guide was published. 
Some of this 
information may 
change over time.
E n h a n c e d  C U - S e e M e
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Using Enhanced 
CU-SeeMe 
Windows

When you start Enhanced CU-SeeMe, several windows appear on your 

desktop. This section explains the components of each of these 

windows, briefly describing their options. You may want to have the 

application running while reading this section to see how these windows 

work.

There are many icon buttons on the Enhanced CU-SeeMe windows, 

each one with a specific function. A summary of the icons that appear in 

these windows and their uses is provided in “Summary of Enhanced 

CU-SeeMe Icons” on page 1-24.

Main Application Window (Windows only)
In Windows, the main application window, illustrated in Figure 1-4, 

appears when you start Enhanced CU-SeeMe.

Figure 1-4: Windows Main Application Window

The main application window has a menu bar, a button bar, and a status 

bar. By choosing commands from the menu bar or from the button bar, 

you can access the many features of Enhanced CU-SeeMe.

Menu bar

Button bar

Status bar

Minimize Close

Maximize

Tip:

In Windows, 
pressing the Home 
key brings the main 
application window 
to the front.
1-13
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The main application window button bar is shown in detail in Figure 1-5 

and the main application window status bar is shown in detail in Figure 

1-6.

Figure 1-5. Main Application Window Button Bar

Figure 1-6. Main Application Window Status Bar

Menu Bar (Macintosh only)
On the Macintosh, the menu bar, shown in Figure 1-7, appears when 

you start Enhanced CU-SeeMe.

Figure 1-7. Macintosh Menu Bar

By choosing commands from the menu bar, you can access the many 

features of Enhanced CU-SeeMe.

Phone book

Hang up 

Stop
sending 
video

Stop 
receiving

video

Chat

WhitePineBoard 

Show
all

Close
all

Audio

Participants

Cascade
video

windows

Tile
video

Help
contents

Context 
sensitive

helpwindows

Status message Your IP address IP address to which 
you are connected

TM
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Local Video Window
The local video window, shown in Figure 1-8, appears after you start 

Enhanced CU-SeeMe. If your camera is properly connected, your 

picture will appear in the window along with a button bar and status 

bars. If you do not have a camera, or if your camera is not working, only 

the button bar and status bars appear.

Figure 1-8. Local Video Window 

 

Status bars

Button bar

Insert Windows screen here
Replace Mac screen too

Macintosh

Windows

Button bar

Status bars

Tip:

If you click the right 
mouse button on the 
video window, you will 
see a pop-up window 
listing menu options.

(Windows only)
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The local video button bar is shown in detail in Figure 1-9 and the local 

video status bars are shown in Figure 1-10. 

Figure 1-9: Local Video Button Bar

Figure 1-10: Local Video Status Bars

Click to flip the
image; does not
transmit this way

Click to hide
the status line

Click to freeze
video transmission

Click to display
the preferences
dialog box

(Windows only)

Number of frames
per second (fps)
being transmitted

Status of the connection:
waiting, timed-out,

connecting, or 

Maximum number of
kilobits per second 
(kbps) that you can

Number of kilobits
per second that you
are receiving

Maximum number of
kilobits per second 
(kbps) that you can receive

disconnected

transmit

(Macintosh only)

Tip:

If you click and hold the 
Preferences button in the 
local video button bar, 
you will get a pop-up 
menu showing available 
Preference sections. 
(Macintosh only)
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Remote Video Window
Each remote video window contains a button bar, a status bar showing 

the status of the connection, and video images being sent by another 

participant in the conference. Figure 1-11 shows the components of a 

remote video window.

Figure 1-11. Remote Video Window

Insert Windows screen

Replace Mac screen too

Macintosh

Windows

Button Bar

Status Bar

Button Bar

Status Bar

Tip:

If you click the right 
mouse button the video 
window, you will see a 
pop-up window listing 
new options.
(Windows only)
1-17
U s i n g  E n h a n c e d  C U - S e e M e  W i n d o w s



1-18

1

W
ha

t i
s 

En
ha

nc
ed

CU
-S

ee
M

e?

The remote video button bar is shown in detail in Figure 1-12, and the 

remote video status line is shown in Figure 1-13 below.

Figure 1-12: Remote Video Button Bar

Figure 1-13: Remote Video Status Bar

User has your video 
window closed

User cannot
hear you

Display transmission
data

You can hear
the user

Data is being 
transmitted
(Macintosh only)

Display IP address,
send and receive settings,

and CU-SeeMe version
video codec information,

Number of frames
per second (fps) you 

receiving

Number of kilobits
per second (kbps) you 
are receivingare
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Audio Window
You can transmit audio in your choice of two modes:

◆ Push To Talk mode - You only transmit audio when a button is 

pressed.

◆ Hands Free mode - You transmit audio continuously. Everything 

you say is transmitted.

If your PC sound card supports full-duplex audio, you can use Hands 

Free mode, which lets you talk while listening (similar to a telephone). 

If your audio sound card supports half-duplex audio, you can still use 

Hands Free mode, but you cannot talk and listen at the same time (that 

is, you can only receive audio when you are not talking). Macintoshes 

all come with built-in full-duplex audio. For Windows computers, it will 

depend on the features of your sound card.

The audio window, shown in Figure 1-14, allows you to control the 

sound coming in and going out of your computer. You can open the 

audio window by selecting Audio from the Window menu (or main 

window toolbar in Windows). Using the audio window, you can:

◆ Turn your speakers and microphone on and off

◆ Select between Push To Talk mode and Hands Free mode

◆ Filter incoming noise when receiving audio and background noise 

when transmitting audio
1-19
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Figure 1-14: Audio Window

The components of the Audio Window are described as follows:

◆ Speaker button - Click this button to turn your speakers on or off.

◆ Microphone button - Click this button to turn your microphone on 

or off.

◆ Speaker volume - Slide this control up or down to adjust the volume 

of your speaker.

◆ Microphone volume - Slide this control up or down to adjust the 

volume of your microphone.

◆ Echo Reduction - Slide this control up or down to adjust the 

maximum sound level that can be transmitted. Echo reduction is 

used to eliminate feedback, which can occur if your microphone is 

placed near your speakers. The echo reduction slider is only shown 

when you are in Hands Free mode.

Speaker Microphone

Squelch

Echo 
reduction

Microphone 
volume

Speaker
volume

level

Mode
indicator

PTT
button 

button button

Lurkers
button

Indicates the 
audio level
being 
transmitted

Indicates the 
audio level 
received

 
 
 
 

 

 

 
 
 

Tip:

You can also use the 
microphone and speaker 
icons in the Participants 
List and the Remote 
Video Windows to turn 
on/off audio send and 
receive.
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◆ Squelch level - Slide this control up or down to adjust the squelch 

level. This control sets the minimum level for any sound; that is, 

any sound below this minimum volume level will not be 

transmitted. This can be useful when there is background noise in 

your environment. You can adjust the squelch level so that the 

background noise is not transmitted.The squelch level slider is only 

shown when you are in Hands Free mode.

◆ Mode indicator - When you are in Push To Talk mode, the indicator 

reads “Push To Talk.” In this mode, when you want to talk, you 

must click and hold on the mode indicator. It then reads 

“Transmitting.” If you are in Hands Free mode, the mode indicator 

reads “Hands Free.” In this mode, you can talk freely, without 

clicking on any buttons or indicator, similar to using a 

speakerphone. 

◆ PTT button - Click this button to switch between Push To Talk 

mode and Hands Free mode.

◆ Lurkers button - Click this button to turn on or off your ability to 

hear lurkers.

◆ Audio level indicators - If the audio indicator bars turn yellow, this 

means that your computer is having trouble compressing your audio 

signal. The result is that your audio signal is not being sent. Wait 

briefly, and then try again. If you continue to see the yellow bars, 

you should select a different audio codec. See “Selecting Audio 

Compression” Chapter 3 for information on selecting audio codecs.

Participant List Window
The Participant List window, shown in Figure 1-15, lists the participants 

in a conference. Participants may be visible, hidden, or lurkers. You can 

open the participant list window by selecting Participants from the 

Window menu (or main window toolbar in Windows). Using the 

participant list window, you can select which users you will speak to and 

view.

You can also view a list of participants from the Window menu 

(Macintosh only). This may be helpful if you don’t have room for the 

participant list on your desktop.
1-21
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NOTE: In low bandwidth environments, you may wish to view only a 

small number of selected users so as to conserve bandwidth.

Figure 1-15: Participant List Window

Click a visible user to hide 

Click to display video window;

Click to display window

Total number of participants 
connected to conference

Click to hide list

Drag to expand participants list

Note: On the Macintosh, a dark gray block indicates the person is talking. 

video window

that this was the last person to speak.

 (without video)

Indicates participant is a lurker (Macintosh only)

Medium gray block indicates
 In Windows, this is indicated by a green outline.

turns a hidden user into a 
visible user

Tips:

To hear only one 
participant, hold down the 
option key and click that 
participant’s speaker 
icon. To restore all 
speakers, hold down the 
option key and click 
again. (Macintosh only)

Click and hold a 
participant’s microphone 
icon to send your audio to 
that participant only. 

Hold down the command 
key and click a 
participant’s speaker icon 
to turn off audio for 
everyone but that 
participant. 
(Macintosh only)
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In Windows, you can get information about each user (visible users, 

hidden users, and lurkers) in the Participant List window by following 

these steps:

1. Click the right mouse button on the name of a participant. The 
Show Info button is now displayed.

2. Click the left mouse button on the Show Info Button. A pop-up 
window now displays the IP address of the user, their transmission 
setting, and the version of CU-SeeMe they are using.

You can also display the information window this way:

1. Click and hold the right mouse button on the name of a participant. 
The show Info button is now displayed.

2. Drag the mouse pointer over the Show Info button and then release 
the right mouse button.

On the Macintosh, names that appear in red in the Participant List 

indicate users who are sending video using the WhitePine Color codec.
TM
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 Summary of 
Enhanced 
CU-SeeMe Icons

There are many icons that appear in the Enhanced CU-SeeMe user 

interface. To use the product most effectively, you should become 

familiar with these icons and their use. Table 1-1 contains a list of icons 

in the local video window.

Table 1-1 . Local Video Window Icons

Icon Meaning

Flips the video image, for local viewing only.
(Windows only)

Hides/shows status line.

Freezes video transmission. 
Click again to start video movement.

Displays the Preferences dialog box.
E n h a n c e d  C U - S e e M e
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Table 1-2 contains a list of icons used to indicate audio transmissions.

Table 1-2 . Audio Icons

Icon Meaning

You accept audio from a user. 
Click this icon button to turn audio off. 
(Macintosh only - Option click to turn off audio 
for all users except this one.)

When the speaker icon button is pushed in and 
contains a \ (slash), it means either of the 
following:

You have turned off all audio reception and 
you will not receive audio from any users. 
Click on this icon in the audio window to turn 
all audio on.

- or -

You have turned off audio from a selected 
user.

No Speaker 
Icon

When the speaker icon is absent, it means either 
of the following:

You are not able to receive audio
(for example, you do not have speakers 
connected to your computer).

- or - 

A user is not able to send audio to you 
(for example, that user does not have a 
microphone connected to their computer).

Note that on a Windows-based computer, the 
speaker icon is always present. In cases where 
you are not able to receive audio, or the user is 
not able to send audio, you will see a speaker 
with a slash: 

User will hear you when you speak.
1-25
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You can click on the speaker icon or microphone icon in the audio 

window to turn off these functions for all windows. You can turn off 

audio reception from an individual user by clicking the speaker icon on 

their remote video button bar or next to their name on the participant 

list. That user will see a X on the microphone icon on your video 

window (which will appear as a remote video window on their computer 

screen) indicating that you won’t hear them when they speak.

When the microphone icon button is pushed in, 
it means that you are speaking to a user in a 
private conversation.

When the microphone icon button contains a 
small X, it means that a user has turned off their 
ability to hear you when you speak.

When the microphone icon button is pushed in 
and contains a large X, it means either of the 
following:

A user has turned off all audio reception and 
has chosen not to hear anyone speak.

- or -

A user is not able to receive audio
(for example, that user does not have 
speakers connected to their computer).

When the microphone icon button is pushed in 
and contains a \ (slash), it means either of the 
following:

A user can’t hear you because you have 
singled out another user for a private 
conversation.

- or -

You have chosen not to send audio
(that is, you have turned off your microphone).

Table 1-2 . Audio Icons

Icon Meaning
E n h a n c e d  C U - S e e M e
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To establish a private conversation with a user, click that user’s 

microphone icon on their remote video button bar or next to their name 

on the participant list. The microphone icons next to all the other names 

on the participant list (and on all the other remote video windows) will 

show a \ (slash) indicating that those users won’t hear you talk. Click 

the microphone icon again to return to general conference conversation. 

On a Macintosh, you can also click and hold the microphone icon to 

engage a user in a private conversation. This will continue until you 

release the microphone icon.

A green \ (slash) on an icon indicates that you have initiated a change 

(for example, you have turned off your microphone) and you have the 

ability to change that state. A red X on an icon indicates that another 

user has initiated a change (for example, a user has stopped receiving 

audio from you) and only the other user has the ability to change that 

state.
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Table 1-3 contains a list of general status indicator icons.

Table 1-3 . General Status Indicator Icons

Icon Meaning

A black box means that this user is the 
current speaker. A gray box means that this user 
was the last person to speak. (Macintosh only)

A white box means that this user has spoken 
during the past 10 minutes. (Macintosh only)

An open eye means that a user has your video 
window open on their desktop

A closed eye means that your video window is 
not open on a user’s desktop.

A shaded closed eye means that a user has 
video but is not currently sending it.
(Macintosh only)

User is a lurker. 
(Macintosh only)

Displays transmission statistics.

Displays the IP address of the user, their 
transmission settings, the codec they are using, 
and the version of CU-SeeMe they are using.

Data is being transmitted. The left side shows 
data being received, while the right side 
shows data being sent. 
(Macintosh only)
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Keyboard 
Shortcuts

You can use keyboard shortcuts for some of the menu options in 

Enhanced CU-SeeMe. Table 1-4 contains the keyboard shortcuts for 

commands, listed by menu.

Table 1-4 . Keyboard Shortcuts

To Choose Press

For Windows For Macintosh

File menu

Exit Ctrl+Q Command+Q

Conference menu

 Phone Book Ctrl+B Command+B

 Hang Up Ctrl+K Command+K

Window menu

Show All Ctrl+H Command+H

Local Video Ctrl+L Command+L

Tile Video 
Windows

Ctrl+T Command +L
1-29
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Understanding 
Networks

A network is a group of computers that communicate with each other. 

There are three basic types of networks: local area networks (LANs), 

wide area networks (WANs), and the Internet. It is important to 

understand the concept of networking before using Enhanced 

CU-SeeMe, which provides videoconferencing over networks.

Local Area Networks
A local area network (LAN) is made up of two or more computers 

connected together, typically located in the same building. These 

connections are made with serial lines or Ethernet cables, as shown in 

Figure 2-1. Most companies have LANs that share files or send e-mail 

between computers.

Figure 2-1. Example of a Local Area Network

Wide Area Networks
A wide area network (WAN) is similar to a LAN in that two or more 

computers are connected together, but they can be located at different 

geographical locations. WANs are separate LANs connected together. 

Computers in each site are connected together in a LAN, then the LANs 

are connected through telephone lines or other means, as shown in 

Figure 2-2. A company with offices in two different parts of the country 

would set up a WAN for the two offices to exchange data or to 

videoconference.
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Figure 2-2.  Example of a Wide Area Network

Internet
The Internet is a mass of smaller networks connected together, or 

Internetworked. The Internet is really just a logical connection between 

thousands of LANs and WANs. It’s a lot like the telephone system, 

which joins individuals and companies. The actual Internet is made up 

of software to make computers talk together, computers that store the 

information, people who provide the information, and the connections 

that join the various networks. 

The Internet allows you to access more information than ever before. 

Using the Internet, you can electronically send messages to people all 

over the world using e-mail, videoconference, access databases 

worldwide, and browse the World Wide Web. To do this, computers 

must communicate with each other using the same language, or 

protocol. The Internet uses the TCP/IP protocol for connection and 

communication of computer systems worldwide.
2-3
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There are many ways networked computers connect to each other. Some 

computers are connected with actual cables, for example phone lines, 

ISDN, or high bandwidth T1 lines, while others are connected through a 

combination of cables and satellite links. There are companies that 

provide these connections for a fee, called Internet Service Providers 

(ISP). Figure 2-3 shows an example of Internet connections.

Figure 2-3.  Example of Internet Connections
E n h a n c e d  C U - S e e M e
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What is a 
Typical 
Enhanced 
CU-SeeMe 
Connection?

Since Enhanced CU-SeeMe provides videoconferencing over the 

Internet, your computer can connect to other computers all over the 

world, or to other computers in a LAN or WAN environment. 

Depending on your setup, you may connect to a network over a modem 

(used in most home environments) or through an Ethernet or ISDN 

connection (used in most business environments).

Your computer must be able to communicate using the TCP/IP protocol. 

The software (or driver) required depends on your connection:

◆ For modem connections, you need a serial IP driver such as SLIP 

(Serial Line Internet Protocol) or PPP (Point-to-Point Protocol).

◆ For Ethernet or ISDN connections, a TCP/IP driver is required.

See the following section, “What Do You Need?” for a complete list of 

drivers that work with your computer. 

Home/Modem Connections
When using Enhanced CU-SeeMe from your home computer, you are 

probably connected to an Internet provider through a modem. Your 

provider usually supplies you an IP address dynamically. Dynamic 

addressing means that you set up your TCP/IP software to obtain the 

address from the provider at the time of the connection.

You can also find your local internet service provider listed in the 

Internet Service Providers Directory on the World Wide Web at:

http://www.commerce.net/directories/products/isp.

You can also use Enhanced CU-SeeMe on Windows 95 with Internet 

connections provided by some online services such as America 

Online®, Microsoft Network, and AT&T Worldnet (sm). Using 

Enhanced CU-SeeMe, you can connect to a videoconference or 

broadcast on a reflector, and even do point-to-point connections, just as 

if you were connected to the Internet through an Internet service 

provider. However, you should note that online service typically assign 

IP addresses dynamically. This means you may have a different IP 

address each time you connect to your online service.
2-5
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Your IP address appears in the Enhanced CU-SeeMe main application 

window status bar. To find the IP address of another person using 

Enhanced CU-SeeMe, click on the right-most button of that user’s 

remote video window. This displays data about that user’s connection, 

including their IP address.

If you want to make a point-to-point connection, you can call another 

person’s IP address directly. If another user wants to initiate a point-to-

point connection with you, that user can connect to your IP address. 

However, your IP address may be different the next time you connect to 

your online service. If you plan to make a point-to-point connection 

with another user of Enhanced CU-SeeMe, you may wish to contact that 

other person ahead of time via e-mail and set up a time when you will 

both connect to the Internet and can determine your IP addresses at that 

time.

Enhanced CU-SeeMe may not work with America Online accounts, 

since America Online uses different connection methods depending on 

your location. To try using Enhanced CU-SeeMe with America Online, 

you will need to download AOL Winsock, a Windows add-on 

application which allows you to run Internet applications such as 

Enhanced CU-SeeMe. When you are connected to America Online, 

enter the Member Services area, and search for WINSOCK to find 

information explaining what Winsock is and how to download it. Also, 

note that currently you must install the 16-bit version of Enhanced 

CU-SeeMe if you plan to use it with America online. Future releases of 

America Online should support the 32-bit version of Enhanced 

CU-SeeMe. 

To use Enhanced CU-SeeMe with Microsoft Network:

1. Start Microsoft Network.

2. Quit Microsoft Network.

3. Select Stay Connected when you are presented with options to Stay 
Connected or Disconnect.

4. Launch the Enhanced CU-SeeMe application.
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WAN/LAN Connections
Most office networks have computers connected to a LAN/WAN which 

are then connected to the Internet through an ISDN or T1 connection via 

an Internet service provider. If you are making a connection over a 

company network, most likely it will be over an Ethernet cable.
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What Do You 
Need?

There are many ways to use Enhanced CU-SeeMe, depending on the 

hardware and software you have. If you want to transmit video from 

your computer you will need to have a video digitizer card (sometimes 

referred to as a video capture board), or use a video camera that does not 

require a digitizer, such as the Connectix QuickCam. You can receive 

video from other users even if you don’t have a video camera or a video 

digitizer card, however other users will not be able to see you.

If you are using a Macintosh, you already have sound capabilities built-

in to your computer. If you are using Windows, you will need to have an 

audio card installed in your computer in order to send and receive audio.

White Pine maintains a list of recommended video digitizer cards, 

audio, cards, and cameras that work with Enhanced CU-SeeMe. This list 

is published online in our Frequently Asked Questions (commonly 

referred to as FAQs) on the World Wide Web. To reach the White Pine 

FAQ Web page, use the following URL:

http://www.cu-seeme.com

Table 2-1 contains a comprehensive checklist of the minimum 

components you’ll need based on the environment in which you’ll be 

using Enhanced CU-SeeMe. Use the bold headings to locate your 

requirements, then make sure you have each item listed below.
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Table 2-1 . Checklist for Minimum System Requirements

Make sure you have ✔
Network Identity

    IP Address
You can have your own IP address or 

    be assigned one dynamically through an
    Internet provider 

PC Requirements†

    486 processor with 66 MHz clock or better

   10 MB of hard disk space

    8 MB RAM minimum

    Windows 3.1, 3.11, Windows NT, or 
    Windows 95

    TCP/IP (WinSock Compliant)
       Windows 3.1, 3.11 
       Windows 95 - built in

Macintosh Requirements†

    68020 processor with 25 MHz clock 
    or better

    10 MB of hard disk space

    5 MB RAM minimum

    System 7.0 or greater

    TCP/IP
        MacTCP - included in kit
        Open Transport - available from Apple

and built in System 7.5.2
2-9
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Notes:

#   Not required for Macintosh AV models or Connectix QuickCam 

cameras.
@ Built-in on some Macintosh models (check for the Sound In and 

Sound Out options in the Sound Control Panel).

†   Your computer’s processing power greatly affects the speed at which 

Enhanced CU-SeeMe will run. For example, a Pentium™ processor 

or a Power Mac™ will run much faster and you’ll have better results 

than a 486 processor or a 68040 Macintosh. 

Remote Connections

    14.4 Modem (for audio only)
28.8 Modem (for video and audio)

    PPP (included in kit)

Direct Connections

    Ethernet or ISDN

To Send Video

    Digital Camera 

    Video Digitizer # 

To Send Audio

    Microphone@

    Sound Board and drivers (Windows only)

To Receive Audio

    Sound Board and drivers (Windows only)

    Speakers or headset@

Table 2-1 . Checklist for Minimum System Requirements

Make sure you have ✔
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Installing 
Enhanced 
CU-SeeMe from 
Disk or CD

White Pine has made installing Enhanced CU-SeeMe as easy as clicking 

a button. Select the system on which you’ll be installing Enhanced 

CU-SeeMe, then complete the instructions. Make sure you have your 

serial number; it is printed on your registration card. You’ll need to enter 

the serial number during the installation process.

To install Enhanced CU-SeeMe on Windows:

From CD:

See the installation instructions included with your CD.

From Disk:

1. Insert the installer disk (disk 1) into the floppy disk drive.

2. For Windows 95: Click on Start, point to Run, then click.
For Windows 3.1, NT, and Windows for Workgroups: Choose 
Run from the File menu in the Program Manager.  The Run dialog 
box appears.

3. Type the drive letter of your floppy disk drive followed by
:\SETUP. For example: A:\SETUP

4. Click on OK and follow the instructions on your screen.

To install Enhanced CU-SeeMe on Macintosh:

From CD:

See the installation instructions included with your CD.

From Disk:

1. Insert the CD or installer disk (disk 1) into the drive.

2. Double-click on the disk icon.

3. Double-click on the Enhanced CU-SeeMe Installer icon.

4. Follow the instructions on your screen.

TM
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Setting Up Your 
Windows-Based 
Computer 

Before running Enhanced CU-SeeMe, you need to be sure your 

computer is properly set up. Enhanced CU-SeeMe will let you know if 

there are problems with your camera or video capture board, but will not 

provide a specific diagnosis for any problem which may occur. Please 

make sure you check the following areas to ensure a successful first 

attempt at videoconferencing.

Setting Up PPP
PPP is a protocol that allows your computer to make a TCP/IP 

connection using a telephone line and a modem. For remote connections 

over modems, you need to have PPP installed and running on your 

computer prior to starting Enhanced CU-SeeMe. White Pine Software 

provides the White Pine PPP driver when you install Enhanced 

CU-SeeMe. If you didn’t install White Pine PPP, install it from the 

Enhanced CU-SeeMe disks or CD. 

Sending Audio
If you plan to send and receive audio, you must have a sound card and 

sound driver software installed and properly configured. To receive 

audio you need to have speakers or a headset connected to the sound 

output jack. To send audio you need to have a microphone connected to 

the sound input jack. Prior to using Enhanced CU-SeeMe, you may 

want to test your system’s audio capabilities. Most sound card 

manufacturers provide playback files for this purpose. Refer to the 

sound card documentation for information on testing.

Sending Video
If you plan to send video, you must have a camera and camera software 

installed and properly configured. Some cameras may require a video 

capture board and video driver software. Some cameras, such as the 

Connectix QuickCam, do not require a separate video board. Prior to 

using Enhanced CU-SeeMe, you may want to test your camera and 

video capture board. Most video capture board manufacturers provide 

test programs, such as VIDCAP or VIDGRAB. Run this software to 

make sure your camera and capture board have been installed correctly. 

Refer to the video board/driver documentation for information on 

testing. 
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Specifying a Host Name for Your Computer
Every computer on an IP-based LAN, WAN, or the Internet is assigned 

an IP address with a corresponding host name. You can create a HOSTS 

file or edit the HOSTS file on your computer and add the IP address of 

your connection and a name (any name will do). For example:

    200.20.20.20 Willy

If you are using a dial-up connection, the IP number may change for 

each connection and is usually provided when you first connect. You 

may have to change the HOSTS file for your IP stack each time prior to 

using Enhanced CU-SeeMe.
2-13
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Setting Up Your 
Macintosh 

Before using Enhanced CU-SeeMe, you may have to make some 

changes to your Macintosh system setup.

Make sure that the Monitors Control Panel is set to greater than or equal 

to 16 colors or 16 gray scales. Under the Apple menu, choose Control 

Panel and Monitors to change color settings.

Setting Up PPP
PPP is a a protocol that allows your computer to make a TCP/IP 

connection using a telephone line and a modem.For remote connections 

over modems, you need to have PPP installed and running on your 

computer prior to starting Enhanced CU-SeeMe. White Pine Software 

provides the White Pine PPP driver when you install Enhanced 

CU-SeeMe. If you didn’t install White Pine PPP, install it from the 

Enhanced CU-SeeMe disks or CD. 

Sending Audio
If you plan to send audio, you need a microphone and Sound Manager. 

Some systems have microphones built-in or come with one that you 

plug in separately. All supported Macintosh computers have built-in 

speakers. Some systems already have Sound Manager installed. If not, 

you can install this as part of Enhanced CU-SeeMe Custom Install, an 

option you can select when you install the Enhanced CU-SeeMe 

software. 

TM
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Sending Video
If you plan to send video, you must have a camera, camera software, and 

QuickTime® installed and properly configured. Some cameras may 

require a video capture board and video driver software. Macintosh AV 

models have a video capture board built in. Some cameras, such as the 

Connectix QuickCam, do not require a separate video board. If you do 

not have QuickTime installed, you need to install it as part of the 

Enhanced CU-SeeMe Custom Install option.

Prior to using Enhanced CU-SeeMe, you may want to test your camera. 

Most video digitizer cards come with software applications that you can 

use for testing your camera. If video is captured and displayed, your 

camera and board (if required) are working. 

Setting Up a Macintosh AV
For Macintosh AV models, you may need to turn off Geo Port® devices 

and speech recognition in the Sound Control Panel to free up system 

memory. To access the Sound Control Panel, choose Control Panels 

from the Apple menu, then choose Sound. Connect your camera to your 

AV card. When using the AV card for capturing color video, you cannot 

exceed a maximum screen resolution of 800 x 600. This is a limitation 

of the AV card.

Prior to using Enhanced CU-SeeMe, you may want to test your camera. 

If video is captured and displayed, your camera is working. 
2-15
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When You First 
Start Enhanced 
CU-SeeMe

Now that you have the necessary hardware and software installed 

(which was discussed in Chapter 2), you are ready to begin using 

Enhanced CU-SeeMe. Before attempting to make your first connection, 

let’s take a minute to review how to start the application, and what 

happens with the application after startup. 

To start using Enhanced CU-SeeMe on your Windows-based 
computer:

1. Click Start, point to Programs, select Enhanced CU-SeeMe folder, 
then click the Enhanced CU-SeeMe icon. (Windows 95 only)

Double-click the Enhanced CU-SeeMe program group in the 
Program Manager, then double-click the Enhanced CU-SeeMe 
icon. (Windows 3.x and Windows NT only)

2. When Enhanced CU-SeeMe successfully starts, the local video 
window appears on your desktop. If you are using a camera, your 
picture appears in the video window. If you aren’t using a camera, a 
shortened version of the local video window appears. 

3. If you want to change the name of your local video window, select 
Preferences from the Edit menu, or click the Preferences icon in 
your local video window. The Preferences dialog box appears. 
Select the Conferencing tab. In the Title box, type the name you 
want to appear in the title bar of the local video window. This is 
typically your name, company name, country, or e-mail address. 
This is the name other users will see in your video window.

See “Changing Preferences” in Chapter 4 for more information about 

these options.

If you run into any problems, check “What Do You Need” in Chapter 2 

before continuing to “Making a Basic Connection” on page 3-4.

Now that you’ve got the basics covered, you are ready to go!
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To start using Enhanced CU-SeeMe on your Macintosh:

1. Double-click the Enhanced CU-SeeMe folder, then double-click the 
Enhanced CU-SeeMe icon. 

2. When Enhanced CU-SeeMe successfully starts, the local video 
window appears on your desktop. If you are using a camera, your 
picture appears in the video window. If you aren’t using a camera, a 
blank version of the local video window appears. 

3. The Preferences dialog box usually appears automatically the first 
time you access Enhanced CU-SeeMe. If it does not appear, then 
select Preferences from the Edit menu. The Preferences dialog box 
appears. Select the Conferencing panel from the pop-up menu. 

4. In the Title box, type the name you want to appear in the title bar of 
the local video window. This is typically your name, company 
name, country, or e-mail address. This is the name other users will 
see in your video window.

See “Changing Preferences” in Chapter 4 for more information about 

these options.

If you run into any problems, check “What Do You Need” in Chapter 2 

before continuing to “Making a Basic Connection” on page 3-4.

Now that you’ve got the basics covered, you are ready to go!

TM
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Making a Basic 
Connection

This section guides you through a basic connection, explaining the 

various ways you can conference using Enhanced CU-SeeMe: seeing 

other users, typing text to other users, hearing other users, and talking to 

other users. By following the steps below, you can identify any 

problems before attempting a full-scale video conference using 

Enhanced CU-SeeMe.

Seeing
For your first conference, try connecting to White Pine Software, where 

we have a dedicated reflector set up for Enhanced CU-SeeMe users. 

Chances are you’ll meet many other Enhanced CU-SeeMe users on our 

reflector. In addition, you’ll meet some of the White Pine Software 

employees working to bring you new and improved versions of 

Enhanced CU-SeeMe!

Note: Refer to “Understanding Enhanced CU-SeeMe Conference 

Types” in Chapter 1 for more information about reflectors.

To make a connection and view other users:

1. Select Phone Book from the Conference menu (or click the Phone 
Book icon on the main button bar in Windows).

2. Select cu-seeme.com, White Pine Software, or 192.233.34.5 from 
the Phone Book.

3. Click the Call button. The status changes to “Connecting” in the 
local video window, or in the Windows main application window.

4. When a Message of the Day appears from the reflector, read it and 
then click OK. You also may get a list of available conferences from 
which to choose.

Each person sending video to the White Pine Software reflector appears 

in a separate remote video window.

Now that you are connected, let’s go one step further. Try starting a 

dialog with other users by typing in the Chat window. You may want to 

“chat” with other users and verify that they can see you. We’ll cover the 

steps on how to do this in the next section.

Tip:

If a message 
appears stating that 
there are too many 
participants, try 
again in a few 
minutes.
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To start a chat session:

1. Select Chat from the Conference menu (or click the Chat icon on 
the main button bar in Windows).

2. Type text in the lower portion of the Chat window and press Return 
to send the text. Your text now appears in the top portion of the 
window with your name. Anyone that has a Chat window open will 
see your text and you will see the text that other users are typing.

3. Send a typed message letting other users know you are testing your 
Chat window.

You can learn more about using the Chat window in Chapter 4.

Hearing
The next step to a complete video conferencing connection is to hear 

users that are speaking. Remember that you must have speakers set up 

with your computer (some computers have them built in). See “What Do 

You Need” in Chapter 2 for a complete list of system requirements.

To listen to other users:

1. Open the Audio window by selecting Audio from the Window 
menu (or click the Audio icon on the main button bar in Windows).

2. Type a message in the Chat window asking another participant to 
talk. Other participants who have their Chat windows open will see 
your message

3. Watch the indicator under the speaker in the Audio window. You’ll 
see the audio level indicator rise as a person talks. If your audio is 
correctly set up, you should hear sounds when the indicator rises 
above the diamond marker. If not, try the volume control. You can 
easily identify the person speaking by watching for a highlighted 
bar in the Participants List window.

You may need to adjust the speaker levels.  See “Using Enhanced 

CU-SeeMe Windows” in Chapter 1 for information on the Audio Window.
3-5
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Talking
Now you are ready to talk to some of the users in the remote video 

windows. Remember, for this you need to have a microphone. See 

“What Do You Need” in Chapter 2 for a complete list of system 

requirements.

To talk to other users:

1. Click and hold the Push to Talk button in the Audio window. The 
button changes to Transmitting so you can talk to the other users. 

2. Click on the microphone icon in a particular user’s window to talk 
directly to that user only.

You may need to adjust the audio levels in the Audio window.  See 

“Using Enhanced CU-SeeMe Windows” in Chapter 1.
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Managing Your 
Connection

Congratulations on a successful videoconference! Now you can fine 

tune your system for optimal performance. As discussed in 

“Understanding Data Transmission” in Chapter 1, Enhanced CU-SeeMe 

uses codecs to compress the audio and video data being transmitted over 

the network. Depending on your network connection and the type of 

computer you are using, there are many options available for using 

Enhanced CU-SeeMe efficiently.

Sending Color vs. Grayscale Video
Enhanced CU-SeeMe supports color and/or grayscale video. Before you 

select the type of video you want to send, you should consider the 

factors listed in Table 3-1:

To select color or grayscale video:

1. Select Preferences from the Edit menu or click the Preferences icon 
in your local video window.

2. Click the Video tab (Windows) or select Audio/Video from the 
Group pop-up menu (Macintosh).

Table 3-1 . Color Versus Grayscale Video

Sending Color Video Sending Grayscale Video

Uses less CPU power. Uses more CPU power.

Displays video at a faster frame 
rate than grayscale.

Displays video at a slower 
frame rate than color.

Uses less bandwidth. Uses more bandwidth.

Uses more application memory. Uses less application 
memory.

Your video will be seen only by 
users of Enhanced CU-SeeMe. 
Users of freeware CU-SeeMe 
will not be able to see your 
video, although you will still see 
their video. However, you will be 
able to hear, talk, and chat with 
all users.

You will have full video and 
audio conferencing with all 
users.
3-7
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3. In the Video group, select a video codec from the Codec list. Select 

WhitePine Color to send color video or CU-SeeMe Gray to send 
grayscale video.

4. Set the quality of the video for color, or brightness/contrast for 
grayscale by dragging the slider. Click OK.

Each video codec provides additional configuration options.

Selecting Audio Compression
Enhanced CU-SeeMe provides several audio codecs, offering different 

audio compression options. Your choice will depend on your computer 

environment, especially whether you are communicating using a 

modem, a LAN, or an ISDN line. Use Table 3-2 to select the best audio 

codec for your environment.

The DigiTalk and Voxware audio codecs both work well with low 

bandwidths and therefore are both usable with modems, however they 

perform differently:

◆ DigiTalk - able to transmit voice and music

◆ Voxware - able to transmit voice only

Table 3-2 . Audio Codec Recommendations

You can use this 
audio codec

If you are using this

14.4k 
modem

28.8k 
modem

LAN ISDN

DigiTalk (8.5 kbps) ✔ ✔ ✔ ✔

Voxware (2.4 kbps) ✔ ✔ ✔ ✔

Delta-Mod (16 kbps) ✔ ✔ ✔

u-law (64 kbps) 
(Macintosh only)

✔ ✔

Intel® DVI (32 kbps) ✔ ✔
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To select audio compression:

1. Select Preferences from the Edit menu or click the Preferences icon 
in your local video window.

2. Click the Audio tab (Windows) or select Audio/Video from the 
Group pop-up menu (Macintosh).

3. In the Audio group, select an audio codec from the Codec list. 
Click OK. Some codec choices may be dimmed. This indicates that 
they are not usable for your computer.

Each audio codec provides additional configuration options. 

Setting Transmission and Reception Rates
You can set the rate at which you send and receive video and audio data 

to maximize performance. Table 3-3 shows general guidelines for 

setting transmission and reception rates.

Enhanced CU-SeeMe selects 80 kbps as the default transmission rate. If 

you are on a LAN or have a connection with higher bandwidth, you can 

increase this rate for better performance. However, if you are 

transmitting with a 28.8k modem, you will be limited to a transmission 

rate of 28 kbps.

The reception options set the rate at which you receive audio and video. 

Limiting reception may be important if you have a 28.8k modem 

connection. If you are set to receive 30k for example, you may not be 

able to send any data out.

Table 3-3 . Setting Transmission and Reception Rates

When using Set transmission and reception rates to

Modem Match the speed of your modem, such as 14 
kbps or 28 kbps

LAN 80 kbps or higher, depending on the 
configuration of your LAN

ISDN 40 kbps or higher, depending on the properties 
of your ISDN line

Tip:

When participating in a 
group conference, you 
may find that many 
reflectors disconnect 
you if your transmission 
rate is higher than 80 
kbps, and may prevent 
you from reconnecting 
for up to 10 minutes.
3-9
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To set the transmit and receive rates:

1. Select Preferences from the Edit menu or click the Preferences icon 
in your local video window.

2. Click the Communications tab (Windows) or select 
Communications from the Group pop-up menu (Macintosh).

3. Set the minimum and maximum values for transmitting and 
receiving by clicking the arrows or by typing values. See Table 3-3 
to determine the correct setting for your connection.

Other Ways of Increasing Performance
Adjusting the compression, transmission, and reception options in 

Enhanced CU-SeeMe are some of the ways you can tailor your session 

for better performance.

Each window you have open on your screen requires memory. The more 

memory Enhanced CU-SeeMe has available, the more efficiently it will 

run. If you find that Enhanced CU-SeeMe is somewhat sluggish, try 

closing some of the windows that are open. Note that video windows 

take up the most memory. Open video windows also use bandwidth, 

which can cause sluggish performance.
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Tuning Your 
Video 
Performance

You may wish to adjust your settings to improve the video image you 

transmit. Many of the default video settings in Enhanced CU-SeeMe can 

be changed using the Preferences dialog box. 

To change a video preference setting:

1. Select Preferences from the Edit menu or click on the Preferences 
icon in your local video window.

2. Select the Video preferences group by clicking on the Video tab 
(Windows) or selecting the Audio/Video group name from the 
pop-up menu (Macintosh).

3. For Windows: Click on the Configure button.
For Macintosh: Click on the Set button. The Compression Settings 
window will appear. Now click on the Options button.

4. The Configure dialog box will appear, as shown in 
Figure 3-1.

Figure 3-1. Configure Dialog Box
3-11
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Configuring the WhitePine Color Video Codec
Use the Configure Dialog box (see Figure 3-1) to configure the 

WhitePine Color video codec. A codec is software that compresses and 

decompresses your video (or audio) data so that it can transmit more 

easily across phone lines or a network. The specific features of the 

WhitePine Color codec are described below. If you wish to change the 

appearance of the video you send, a good general rule is to modify the 

values of the codec in this dialog and see how those changes affect the 

performance of your remote video when you connect to Self.

Smeared “I” Frame Rate
Your video data is transmitted as a series of frames, which are updated 

continuously. In order to get the smoothest possible video with the least 

amount of data loss, the video codec looks at the changes from one 

video frame to the next, compresses this changed data, and then adds 

this data to the previous frame. The result is that the video image you 

transmit is updated as you move in front of your camera. Unfortunately, 

there is usually some unavoidable loss of data as your video image is 

sent across a network. To compensate for this loss and to make sure 

unwanted “noise” won't build up on the connection, a full frame 

(containing ten times more data than a typical frame which only 

includes the changes since the previous frame) is periodically 

distributed (or “smeared”) over a number of frames. This number of 

frames is specified by the Smeared “I” Frame Rate. The Smeared “I” 

Frame Rate determines the timing of this insertion. A lower number 

means that this full frame is inserted more often.

The default Smeared “I” Frame Rate is 45, which takes into account the 

amount of noise on a typical Internet connection. For connections over a 

LAN, where there is much less noise, the rate of insertion can be 

increased, which means changing the setting to a lower number.
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Gamma Correction Factor
The Gamma Correction Factor is similar to the brightness control on a 

television set. On the Gamma Correction Factor scale, the higher the 

number, the brighter the picture.

The default setting is 33, which means there is no Gamma Correction. 

The Gamma Correction affects only the video windows that you see on 

your computer monitor. It does not affect the video that you transmit to 

others.

Apply Noise Reduction Filter
The hardware components of some low-end cameras generate a lot of 

static noise, which is difficult to compress. When the Apply Noise 

Reduction Filter box is checked, an extra operation is added in which 

noise is filtered before going through the codec (COmpression-

DECompression) process. The result is a picture that is received with 

less noise. The picture will also use less bandwidth if the noise is filtered 

out. Note that this filter will only affect how other users see your video 

image. Using this filter uses some CPU power from your computer, but 

it can be helpful to clean up the image sent by your camera.

Lossless Options
The term lossless means a perfect replication of a picture so that the 

picture, after it has been compressed and decompressed, is exactly the 

same as it was before entering this process. That is, no quality is lost in 

the picture. 

There are three lossless options:

◆ Luminance - preserves brightness and contrast

◆ Chrominance - preserves color

◆ Quality - preserves clarity (no blurring)

Note that the Quality option is found on the Video preferences tab on a 

Windows computer, and on the Compression Settings window on the 

Macintosh. If you aren’t sure how to find these windows, see “To 

change a video preference setting:” on page 3-11.
3-13
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You can transmit in high quality lossless mode by checking these 

options and setting Quality to100%. Check Lossless Luminance to 

transmit lossless grayscale; check both Lossless Luminance and 

Lossless Chroma for color. 

Achieving this high quality mode is expensive in terms of the amount of 

bandwidth used. A perfect picture replication is possible, but it can 

reduce your frame rate. The default for both options is to be turned off.

ME Search Radius
Use the ME (Motion Estimator) Search Radius to establish the 

neighborhood in which the WhitePine Color codec's Motion Estimator 

compares motion between one video frame and the next. The Motion 

Estimator looks in a search radius (or neighborhood) of X pixels of the 

video subject, where X is the number of pixels entered in the ME Search 

Radius box. The default is 8 pixels.

If there is going to be a lot of motion in your video, a wider radius 

means a smoother picture. This uses less bandwidth, however, it can be 

expensive in terms of the amount of CPU used.

Bit Stream Data
The default transmission mode for the WhitePine Color codec is, 

appropriately, color. You can, however, choose to use the WhitePine 

Color codec but transmit in gray images by clicking on the Gray Scale 

radio button in this dialog box. Typically, removing the color 

information from the bit stream in this way results in a 10%-20% 

reduction in the bandwidth requirements.
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Arranging 
Windows

With the audio, chat, participant and video windows displayed, your 

desktop may appear cluttered at times. Enhanced CU-SeeMe helps you 

to organize these windows by letting you show all video windows, close 

all video windows, and even save window positions so your choice of 

locations can be restored each time you use Enhanced CU-SeeMe.

To arrange video windows:

1. Select Cascade Video Windows from the Windows menu to stack 
the windows on top of each other, starting in the upper left corner of 
your display. (You can also click the Cascade Video Windows icon 
on the main button bar in Windows.)

2. Select Tile Video Windows from the Windows menu to arrange the 
windows in a grid, starting at the upper left corner of your display. 
(You can also click the Tile Video Windows icon on the main button 
bar in Windows.)

To toggle the video window size:

Click the Zoom button on the Video window to make the window small 

(160x120) or large (320x240).

To save window positions:

1. Select Preferences from the Edit menu or click the Preferences icon 
in your local video window.

2. Click the General tab (Windows) or select General from the Group 
pop-up menu (Macintosh).

3. Select the Save Windows Positions on Exit option. Click OK.

To open specific windows or bring them to the front:

◆ Select Participants, Audio, or Local Video from the Windows menu.

◆ Click on a participant from the participant list.

Cascade video windows

Tile video windows
3-15
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To display or close all remote video windows on your 
desktop:

◆ Select Show All or Close All from the Windows menu.

◆ Select Close All Except Front to close all windows in the 

background. To redisplay them, choose Show All.

Note: Show All only displays the number of video windows specified in 

the Conferencing Preferences (default is 8).

To display a single participant’s window:

Click the participant’s name from the list of hidden users in the 

Participants window.

To limit the number of windows that appear on your desktop:

1. Select Preferences from the Edit menu or click the Preferences icon 
in your local video window.

2. Click the Conferencing tab (Windows) or select Conferencing from 
the Group pop-up menu (Macintosh).

3. Select the number of windows in the Maximum Video Windows 
box by clicking the arrows.
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 Adding Overlay 
Text to Your 
Local Video 
Window

When you are sending video, you may want other users to see additional 

information such as your location, your company name, or a brief 

greeting. You can easily do this by overlaying a text message on your 

video window, as shown in Figure 4-1.

Figure 4-1. Video Window Overlay Text

To add overlay text to your video window:

1. Click on your local video window to select it as the active window.

2. Begin typing text. Your message will appear in your video window.

3. With your local video window active, press Enter to remove the 
overlay text when you no longer want it to appear.

Enhanced CU-SeeMe users who see your video window will also see 

your overlay text message. Continue with the following sections to learn 

how you can modify the appearance of your overlay text. 

Modifying Your Overlay Text 
As a default, the overlay text is displayed in the system font, however, 

you can change the font type and size (Windows only). You can also 

have your overlay message appear at the top or bottom of your video 

window. 
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Your overlay text message may can contain as many as 256 characters, 

although if you type a long message, it will not all fit in your window. To 

show your entire message, you can have your overlay text scroll across 

your screen from right to left. You can also choose to have your overlay 

text remain fixed in one location on your video window.

To change the overlay text font (Windows only):

1. Press the F8 key to display the Font dialog box, as shown in 
Figure 4-2.

2. Select the font settings you want for your overlay text. Click OK.

The overlay text will now appear in the font you selected.

Figure 4-2. Overlay Text Font Dialog Box
4-3
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Moving Overlay Text Within Your Video Window
By default, your overlay text will appear at the bottom of your video 

window. You can choose to move it to the top of your video window, or 

have it scroll across the screen. To do this, use the arrow keys and 

function keys on your keyboard. Refer to Table 4-1 to find out how to 

move your overlay text.

Table 4-1 . Moving Overlay Text

Press this key To do this

Move the overlay text to the top of the video 
window.

Move the overlay text to the bottom of the video 
window.

Scroll the overlay text from right to left across the 
video window.

Press the arrow again to increase the speed of the 
scrolling text (Macintosh only).

Stop scrolling the overlay text.

Also used to decrease the speed of the scrolling 
text (Macintosh only).

F6 Increase the speed of the scrolling text
(Windows only).

F7 Decrease the speed of the scrolling text
(Windows only).
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Using the Chat 
Window

For true videoconferencing, you’ll want to use video and audio. 

However, you can also use the Chat Window to type messages to other 

participants. This is especially helpful if either you or the remote user 

with whom you wish to conference don’t each have a camera or 

microphone, or if your bandwidth connection is too limited to carry 

audio.

To use the Chat Window:

1. Choose Chat from the Conference menu (or click the Chat icon on 
the main button bar in Windows). The Chat Window appears, as 
shown in Figure 4-3.

Figure 4-3.  Chat Window

2. Type a message in the lower portion of the Chat Window and press 
the Enter key to send your message. Your message now appears in 
the top portion of the window with your name, as it appears in the 
title bar of your local video window. Anyone who has a Chat 
Window open will see your message. Figure 4-4 shows an example 
of how a “chat” conversation appears in the window.
4-5
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Figure 4-4.  Example of Using the Chat Window

You can modify the appearance and use of the Chat Window. Continue 

with the following sections to learn more about the Chat Window 

features.

Type here and
press Enter
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Filtering Other Participants
There are times when you may not want to see all the conversations 

happening in the Chat Window. It may be useful to prevent text from 

certain people from appearing in your Chat Window.

To filter text in the Chat Window:

1. In the Chat Window, double-click the name of the user you want to 
filter out. The Chat Window Filter dialog box appears, as shown in 
Figure 4-5.

Figure 4-5.  Chat Window Filter Dialog Box

2. Select the Filtered checkbox and click OK.

3. Click Filter at the bottom of the Chat Window to start filtering the 
text. Text from the user you filtered will not appear in your window.

4. To stop filtering text, click Filter again. The Filter button toggles 
filtering on and off.

5. Click Reset to clear all names from the filter.
4-7
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Setting Font and Font Size
As a default, the Chat Window uses the system font to display the text in 

the Chat Window. You can change the font type and size using the 

Configuration feature. 

To change the text appearance:

1. Click Config at the bottom of the Chat Window. The Chat Window 
Font (Windows) or Font/Size (Macintosh) dialog box appears, as 
shown in Figure 4-6.

Figure 4-6. Chat Window Font Dialog Box

Windows

Macintosh
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2. Select the font settings you want to display in the Chat Window. 

Click OK.

All text in the Chat Window changes to the font you selected.

Resizing the Chat Window
You can resize the Chat Window to display more text, as shown in 

Figure 4-7. 

Figure 4-7.  Chat Window Controls

Drag to resize the top and 
bottom portions of the window
(only works on the Macintosh
if you’ve changed the window
size using the grow box) 

Drag to change the
size of the window
(Macintosh)
4-9
U s i n g  t h e  C h a t  W i n d o w



4-10

4

W
ha

t E
ls

e 
Ca

n
Yo

u 
Do

?
 Using the 
Listener

Communicating with other users over the Internet using Enhanced 

CU-SeeMe may become as commonplace as using the telephone. 

However, it may not be practical to leave Enhanced CU-SeeMe running 

at all times because of its use of your system resources. To make sure 

you don’t miss an incoming call, you can run the Listener to alert you of 

an incoming call by:

◆ Displaying an alert message

◆ Playing a system sound

◆ Flashing an icon in the menu bar (Macintosh only)

The Listener is an application built into Enhanced CU-SeeMe. It can let 

you know if someone is trying to call your computer, even when you are 

already connected to a conference or another call.

The Listener can also be running on your computer when you are not 

using Enhanced CU-SeeMe. It will listen for anyone who may try to 

connect to your computer and it will notify you. You can accept or deny 

the connection. If you accept the connection, the Listener automatically 

starts up Enhanced CU-SeeMe so you can begin conferencing with the 

caller.

To set up the Listener:

1. Double-click the Listener icon in the Enhanced CU-SeeMe folder. 
The first time you run the Listener, the Preferences dialog box 
appears (Macintosh only), as shown in Figure 4-8.

Figure 4-8.  Selecting the Alert Method for Incoming Calls
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2. Select a method to alert you of an incoming call. You can change 

the alert method later by selecting Preferences from the Edit menu 
or clicking the Preferences icon in your local video window. If you 
are setting the preferences from within the Enhanced CU-SeeMe 
application, click the Listener tab (Windows) or select Listener 
from the Group pop-up (Macintosh).

3. Keep the Listener running in the background while you do your 
work.

To answer an incoming call:

1. The Connection Request window, shown in Figure 4-9, appears 
when another user is requesting a connection to your computer. 
Make the Listener application active by clicking the window.

Figure 4-9. Connection Request Window

Name of 

Click to answer 

the caller

the call

Click to display the options

Click to refuse 
the call
4-11
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2. The default is to send and receive video and audio when answering 

the call. To change the video and audio options, click the down 
arrow to display the options, as shown in Figure 4-10.

Figure 4-10. Selecting Video and Audio Options

If any of these options appear grayed out, this indicates that either 

you or the caller do not have video or audio capability, therefore 

you may want to use the Chat Window, or the WhitePineBoard 

for two-way communication. See “Using the Chat Window” on 

page 4-5.

3. Click Answer. If the button is dimmed, this indicates that you 
already have a connection open. Choose Hang Up from the 
Conference menu (or click the Hang Up button on the main button 
bar in Windows) to close the existing connection.

If you choose to refuse the call, or you exit Enhanced CU-SeeMe before 

responding to the incoming call, the Listener application will notify the 

caller by displaying a Connection Refused message on the caller’s 

display.

Click to display or
hide options
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Setting Up the 
Phone Book

After using Enhanced CU-SeeMe to contact individuals or join 

conferences, you may wish to create a list of addresses for calls you 

frequently make using Enhanced CU-SeeMe. The Enhanced CU-SeeMe 

Phone Book provides a means of storing these addresses with 

nicknames that you can choose. For example, you can store the IP 

address of an individual user or the IP address of a reflector and assign it 

a nickname.

Using the phone book, you can:

◆ Add nicknames to the Call submenu in the Conference menu

◆ Make calls directly

◆ Add, delete, change addresses and nicknames

The phone book dialog box is shown in Figure 4-11.

Figure 4-11.  Phone Book Dialog Box

Displays the 

defined 
list of 

nicknames 

IP address

selected 
Nickname

of the
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To add names to the phone book:

1. Select Phone Book from the Conference menu (or click the Phone 
Book icon on the main button bar in Windows).

2. Click New to create a new entry.

3. Complete the Nickname dialog box as shown in Figure 4-12.

Figure 4-12.  Creating a Nickname

4. Click OK to add the nickname to the phone book.

5. Click Close in the Phone Book dialog box (Windows) or select 
Save from the File menu (Macintosh) to save changes to the phone 
book or click the close box and select Save in the dialog box 
(Macintosh). 

To change a phone book entry:

1. Select Phone Book from the Conference menu (or click the Phone 
Book icon on the main button bar in Windows).

2. Select a name from the list of nicknames.

3. Click Edit.

4. Change the values as desired. Click OK.

5. Click Close in the Phone Book dialog box (Windows) or select 
Save from the File menu to save changes to the phone book or click 
the close box and select Save in the dialog box (Macintosh). 

Type a nickname for 
the connection

Type the IP address 
of the connection
Select to send your 
video to connected user

Select to add the 

Select to receive 
video from other 
users 

nickname to the 
Call submenu
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To delete a phone book entry:

1. Select Phone Book from the Conference menu (or click the Phone 
Book icon on the main button bar in Windows).

2. Select the entry to delete from the list of nicknames and click 
Remove.

Note for Macintosh Only: You can select multiple names using 

Command or Shift to select more than one name.

3. Click Close in the Phone Book dialog box (Windows) or select 
Save from the File menu to save changes to the phone book or click 
the close box and select Save in the dialog box (Macintosh). 

To make a call using the phone book:

1. Select Phone Book from the Conference menu (or click the Phone 
Book icon on the main button bar in Windows).

2. Select the name of the person or conference to which you want to 
you connect.

3. Specify the conference ID for the conference you want to join. 
Most conferences use the default 0. If a private conference has been 
set up, obtain the conference ID from the Conference 
Administrator. When you save a conference in the Phone Book, the 
conference ID is also saved.

4. Click Call.

Enhanced CU-SeeMe attempts to make a connection to the conference 

you specified. If the connection is successful, the person or conference 

you connected to appears in a remote video window(s).
4-15
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 Setting Up 
Enhanced 
CU-SeeMe on a 
Web Page

Enhanced CU-SeeMe can be launched directly from a Web browser.   

By setting up Enhanced CU-SeeMe for access from a Web page, you 

can access additional information that wouldn’t be feasible if you were 

to use Enhanced CU-SeeMe by itself. For example, you may want to set 

up a camera to display a classroom. Although this could be done using 

Enhanced CU-SeeMe by itself, you could provide additional materials 

to viewers, such as text and graphics, by placing this material on a Web 

page.

Setting up Enhanced CU-SeeMe for access from a web page requires:

◆ Web Page Creation - create a Web page that points to a file used to 

launch an Enhanced CU-SeeMe conference

◆ Web Site Administration - configure an http daemon on a web 

server

◆ End User Configuration - configure a web browser to launch 

Enhanced CU-SeeMe

Creating the File that Launches a Conference
To launch Enhanced CU-SeeMe from a web page you need to create a 

web page with a hot link to a file that defines the IP address and 

Conference ID of the reflector to which you want to connect. Place this 

file, with the other html files, on the UNIX host.

To create the file:

Create a file with a .cu or .csm extension which contains the following 

parameters, each on its own line:

ip_address

conference_id

file_options

where:

ip_address is IP address of the reflector or Enhanced CU-SeeMe 

host that you would like to connect to using Enhanced CU-SeeMe.
E n h a n c e d  C U - S e e M e



4

W
hat Else Can 

You Do?

conference_id is the conference ID used by the reflector.

file_options are the optional configuration items found in the 

Enhanced CU-SeeMe preferences file.  These settings override the 

defaults in your preferences file. 

An example of this file is shown below (note that you must include the 

section headers), for a file named whitpine.cu, which is used to launch a 

connection to a reflector on a computer with an IP address of 

192.233.34.5.

filename: whitpine.cu

192.233.34.5

0

[Settings]

Max Windows=n  n is the number of video windows you 

want visible on the screen

[Flow Control]

MaxCap=n n is the maximum sending rate

MinCap=n n is the minimum sending rate

UseFlowControl= Yes to enable flow control

No to disable

[Connect Options]

IWillSendVideo= Yes to send video

No to send none

IWillRecvVideo= Yes to receive video

No to receive none

IWillSendAudio= Yes to send audio

No to send none

IWillRecvAudio= Yes to receive audio

No to receive none
4-17
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Configuring a Web Server
When a Web browser downloads a .cu or .csm file, the http daemon in 

the Web server needs to inform the browser that the file it is sending is 

an x-cuseeme file.

To set up your web server:

1. Edit the mime.types file typically located in the /http/conf/ directory 
(the http configuration directory) to include the following line:

        application/x-cuseeme  cu csm

This tells the http daemon that if it receives a file with either 

the .cu or .csm extension, it is type x-cuseeme.

2. Restart the http daemon.

Configuring a Web Browser
Your browser must know how to launch Enhanced CU-SeeMe when it 

receives the Enhanced CU-SeeMe file described in the previous section. 

Your browser may prompt you to launch Enhanced CU-SeeMe, or you 

may set up your browser to automatically launch the Enhanced 

CU-SeeMe application when it detects the x-cuseeme type. 

To set up your browser to automatically launch Enhanced 
CU-SeeMe:

1. Locate the dialog box to add new file types in your browser, 
typically in a preferences dialog box. For example, in Netscape™, 
select General Preferences (Windows) or Preferences (Macintosh) 
from the Options menu, then select Helper Applications. 

2. Click the Create New Type button (Windows) or 
New button (Macintosh). 

3. Specify the Mime type: application

4. Specify the Mime subtype: x-cuseeme
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5. Specify the file extensions: cu, csm

6. Specify Enhanced CU-SeeMe as the application.

Note for Windows: Make sure Enhanced CU-SeeMe is in your 

path, or specify the full pathname for the cuseeme executable.

7. Set the action to launch the application.
4-19
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 Changing 
Preferences

Many of the default settings in Enhanced CU-SeeMe can be changed 

through the Preferences dialog box. 

To change a preference setting:

1. Select Preferences from the Edit menu or click on the Preferences 
icon in your local video window.

2. Select a Preferences group by clicking on a tab (Windows) or 
selecting the group name from the pop-up menu (Macintosh). Note 
that on the Macintosh, the Audio and Video preference groups are 
combined into one Audio/Video group. In Windows, Audio and 
Video are on two separate tabs.

3. Refer to Table 4-2 to find out what settings can be changed in the 
General Preferences dialog box.

4. Refer to Table 4-3 to find out what settings can be changed in the 
Conferencing Preferences dialog box.

5. Refer to Table 4-4 to find out what settings can be changed in the 
Communications Preferences dialog box.

6. Refer to Table 4-5 to find out what settings can be changed in the 
Audio Preferences dialog box. Note that on the Macintosh, this is 
combined with the Video preference group.

7. Refer to Table 4-6 to find out what settings can be changed in the 
Video Preferences dialog box. Note that on the Macintosh, this is 
combined with the Audio preference group.

8. Refer to Table 4-7 to find out what settings can be changed in the 
Listener Preferences dialog box.
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Table 4-2 . Changing General Preference Settings

Change this setting To do this

Show toolbar/Show status bar in 
video windows

Hide/show toolbar and status 
bar in all video windows

Show toolbar/Show status bar in 
main window (Windows only)

Hide/show toolbar and status 
bar in all video windows

Buttons “click” when pressed Start/stop the click sound when 
selecting buttons

Save window positions on exit Save/don’t save window 
positions

Separate visible/hidden users
(Macintosh only)

Separate/don’t separate visible 
and hidden users in the 
participants list

Window sizing: Automatic grow 
downward, Automatic grow 
upward (Macintosh only)

Select how the participants 
window acts when new 
participants appear

Tile/cascade small video 
windows (Macintosh only)

Make all video windows small/
large when tiling/cascading

Auto-tile remote video 
windows (Windows only)

Override saved window posi-
tions and tiles the windows
4-21
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 Table 4-3 . Changing Conferencing Preference Settings

Change this setting To do this

Title Change title of your video 
window

Open and close video windows 
automatically

Stop/start video windows from 
automatically opening and 
closing when a new video 
connection is available

Click when participants join Stop/start the click sound when 
a new participant joins the 
conference

Maximum video windows Limit the number of video 
windows that appear on your 
desktop to no more than eight

Table 4-4 . Changing Communications Preference Settings

Change this setting To do this

Transmission rate - Maximum Set the maximum rate at which 
you send audio and video

 Transmission rate - Minimum Set the minimum rate at which 
you send audio and video

Transmission rate - Maximum 
without audio (Macintosh only)

Set the maximum rate for video 
only

 Reception rate - Maximum Set the maximum rate at which 
you receive audio and video

 Reception rate - Minimum Set the minimum rate at which 
you receive audio and video 
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Table 4-5 . Changing Audio Preference Settings

Change this setting To do this

Audio compression codec Select audio codec

Recording device
(Windows only)

Select sound input device

Playback device
(Windows only)

Select sound output device

Table 4-6 . Changing Video Preference Settings

Change this setting To do this

Video compression codec Select video codec

Invert image (Windows only) Flip the image vertically

Invert gray table (Windows only) Reverse dark and light pixels 
(turn negative image to positive 
image)

Quality (Windows only) Adjust color quality and bright-
ness/contrast

Video capture device 
(Windows only)

Select video capture device

Digitizer selection 
(Macintosh only)

Select video card or driver 

Digitizer settings 
(Macintosh only)

Change the settings for the 
video card

Resolution (Macintosh only) Select standard or high 
resolution
4-23
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 Table 4-7 . Changing Listener Preference Settings

Change this setting To do this

Enable listener notification: 
On/Off

On = Notify you of an incoming 
call at all times (whether or not 
you are currently connected)
Off = Incoming calls are auto-
matically accepted if you are 
not currently connected; If you 
are connected, incoming calls 
are automatically refused

Notification method:
Flash window, Play a sound
(Windows only)

Signal for incoming calls for the 
LIstener

Notification method:
Display an alert, Play a sound, 
Flash the menu bar icon 
(Macintosh only)

Signal for incoming calls for the 
Listener

Confirm launch of Listener at quit 
(Macintosh only)

Turn off/on alert when Listener 
is starting up after quitting
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Using the 
WhitePineBoard

Using the WhitePineBoard, you can share drawings and documents with 

other participants in a videoconference. You can use a WhitePineBoard 

document to create graphics using the WhitePineBoard tools or to 

import documents from a presentation, word processing, spreadsheet, or 

graphic applications. WhitePineBoard tools allow dynamic editing of 

graphics during the conference session.

When you are connected with another person using WhitePineBoard, 

documents you create, open or import are automatically displayed on 

other computers. Other users can easily mark up, print and save 

documents from their own computers. 

This section provides a brief overview of how to use the 

WhitePineBoard application. Refer to the WhitePineBoard User 

Manual, available as an online document in Adobe Acrobat Reader 

format, for more information.
4-25
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Starting the WhitePineBoard
The WhitePineBoard is a separate application accessed from Enhanced 

CU-SeeMe. Since the WhitePineBoard uses Enhanced CU-SeeMe for 

communications, it is only available when Enhanced CU-SeeMe is 

running.

To start the WhitePineBoard:

1. Select WhitePineBoard from the Conference menu (or click the 
WhitePineBoard icon on the main button bar in Windows).

To create a new document, choose New from the File menu. A 

blank WhitePineBoard appears on your computer and all others 

connected to WhitePineBoard, as shown in Figure 4-13.

Figure 4-13. WhitePineBoard Window

2. To import an existing document, choose Open from the File menu 
and select the document you want to open. 

WhitePineBoard supports the following document formats:

◆ Windows: BMP, EPS, GIF, PCX, PICT, TGA, TXT, TIF, and 

WMF.

◆ Macintosh:  PICT, PICT2, Text, and Scrapbook files.
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3. Instruct other conference participants to start up WhitePineBoard.

Alert messages appear on the participants screens. The 

WhitePineBoard originator receives a message stating who is 

connecting to the conference. The other participants receive a 

message specifying the name of the document originator.

4. Edit the WhitePineBoard document. From the WhitePineBoard tool 
bar, select the pencil to draw freehand, the text tool (letter A) to 
type text, the hand to point at objects, or the pointer to select 
objects.

You can print this document or close it for later use.
4-27
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Sharing a Document with Other Users
Once a document has been created or imported, you are ready to begin 

reviewing it with the other users. With an open connection, the 

document appears on all computers simultaneously. As you view the 

document, scroll through it, and mark it up, all windows change 

appropriately.

You can unlink your document, temporarily disabling view updates 

from the other windows. When you are unlinked, scrolling, zooming, 

and switching documents on your computer does not affect the windows 

of the other users. Documents continue to be updated on all connected 

computers even though you are unlinked.

To unlink your view of the document:

1. Select Link View from the Collaborate menu.

The checkmark disappears from the menu and the View Status icon 

in the upper-right corner changes to a closed eye.

2. To re-establish the link, select Link View again.

The checkmark reappears to the right of the Link View command 

and the View Status icon changes to an open eye.

Saving a Document
You can save a document any time during a WhitePineBoard session for 

use in another application or for use with the WhitePineBoard later.

To save a document:

Choose Save from the File menu.  WhitePineBoard remembers who 

made each comment within the saved document.

Important:

If you opened a 
document created with 
another application, be 
sure to give it a new 
name to avoid 
overwriting the original.
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Printing a Document
You can print a document and its comments at any time during the 

session.

To print a document:

1. Choose Print from the File menu.

The Print dialog box appears.

2. Select the appropriate choices in the dialog box.

3. Click OK to print your document. (Windows)

Click Print to print your document.(Macintosh)

After You’re Done
After you’ve finished working on a document, close the document, 

disconnect from the other users, and quit WhitePineBoard.

To complete a WhitePineBoard session:

1. Make sure you’ve saved your document if desired.

2. To close the document, choose Close from the File menu.

3. To disconnect from other users, choose Disconnect from the 
Collaborate menu.

4. To quit WhitePineBoard, choose Exit or Quit from the File menu.
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Setting Conference Preferences
When you first use WhitePineBoard, default settings are used for your 

connection name, the pointer, and the pointer color.

To change the preferences:

1. Choose Preferences from the Edit menu.

2. To change the pointer shape, select a new pointer from the Pointer 
pop-up menu.

3. To change the pointer color, select a new color from the Color 
pop-up menu.

4. To admit users to a conference without requiring authorization, 
unselect the Ask Before Admitting New Users option.

5. Click OK to close the Preferences dialog box.

The changes take effect the next time you start WhitePineBoard.
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New Audio 
Features

Enhanced CU-SeeMe has new audio features for more flexibility and 

improved performance.

Audio Modes
You can transmit audio in your choice of two modes:

◆ Push To Talk mode - You only transmit audio when a button is 

pressed.

◆ Hands Free mode - You transmit audio continuously. Everything 

you say is transmitted.

If your PC sound card supports full-duplex audio, you can use Hands 

Free mode, which lets you talk while listening (similar to a telephone). 

If your audio sound card supports half-duplex audio, you can still use 

Hands Free mode, but you cannot talk and listen at the same time (that 

is, you can only receive audio when you are not talking). 

Audio Window
The audio window allows you to control the sounds coming in and 

going out of your computer. You can open the audio window by 

selecting Audio from the Window menu, or clicking on the Audio icon 

in the main window toolbar. Using the audio window, shown in Figure 

5-1, you can:

◆ Turn your speakers and microphone on and off

◆ Select whether you wish to push a button to talk (transmitting audio 

on demand) or have your audio transmitted continuously (Hands 

Free mode)

◆ Filter incoming noise when receiving audio and background noise 

when transmitting audio
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Figure 5-1. Audio Window

The components of the Audio Window are described as follows:

◆ Speaker button - Click this button to turn your speakers on or off.

◆ Microphone button - Click this button to turn your microphone on 

or off.

◆ Speaker volume - Slide this control up or down to adjust the volume 

of your speaker.

◆ Microphone volume - Slide this control up or down to adjust the 

volume of your microphone.

◆ Squelch level - The squelch level slider is only shown when you are 

in Hands Free mode. Slide this control up or down to adjust the 

squelch level. This control sets the minimum level for any sound; 

that is, any sound below this minimum volume level will not be 

transmitted. This can be useful when there is background noise in 

your environment. You can adjust the squelch level so that the 

background noise is not transmitted.

Speaker Microphone

Squelch

Echo 
reduction

Microphone 
volume

Speaker
volume

level

Mode
indicator

PTT
button 

button button

Lurkers
button

 
 
 
 

 

Note:
You can also use the 
microphone and speaker
icons in the Participants
List and the Remote 
Video Windows to turn 
on/off audio send and 
receive.
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◆ Echo Reduction - The echo reduction slider is only shown when 

you are in Hands Free mode. If you are receiving audio and sending 

audio simultaneously, the echo reduction control can prevent your 

microphone from sending the sound that is coming from your 

speakers. Raising the echo reduction slider will raise the minimum 

level of sound that you will transmit. Echo reduction will also 

eliminate feedback, which can occur if your microphone is placed 

near your speakers. 

◆ Mode indicator - When you are in Push To Talk mode, the indicator 

reads “Push To Talk.” In this mode, when you want to talk, you 

must click and hold on the mode indicator. It then reads 

“Transmitting.” If you are in Hands Free mode, the mode indicator 

reads “Hands Free.” In this mode, you can talk freely, without 

clicking on any buttons or indicator, similar to using a 

speakerphone. When you are actually sending audio (that is your 

voice goes above the squelch or echo reduction level), then the 

mode indicator reads “Transmitting.” This tells you that your audio 

signal is actually being transmitted to other users.

◆ PTT button - Click this button to switch between Push To Talk 

mode and Hands Free mode. The letters PTT appear in red on the 

button when you are in Push To Talk mode. 

◆ Lurkers button - Click this button to turn on or off your ability to 

hear lurkers. When the word Lurkers appears in red on the button, it 

indicates that you are able to hear lurkers.
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Audio Preferences
Enhanced CU-SeeMe allows you to fine-tune your software to get the 

best audio performance. You can modify audio settings using the Audio 

Preferences dialog box. 

To change an audio preference setting:

1. Select Preferences from the Edit menu or click on the Preferences 
icon in your local video window.

2. Select the Audio Preferences group, shown in Figure 5-2, by 
clicking on the Audio tab. 

Figure 5-2. Audio Preferences
5-5
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3. Select a Compression Codec. The Compression Codec shown in 

Figure 5-2 is DigiTalk (8.5 kbps). If you choose a codec with a rate 
of 2.4 or 8.5 kbps, your audio will only be compatible with other 
users of Enhanced CU-SeeMe. Users of the Cornell freeware 
CU-SeeMe will not hear your audio. If you choose a codec with a 
rate of 16 or 32 kbps, your audio will be heard by users of the 
Cornell freeware as well as users of Enhanced CU-SeeMe. 

However, using a lower rate, such as 2.4 or 8.5 kbps, uses less 
bandwidth and therefore may give better performance. If 
compatibility with the Cornell freeware is not a requirement for 
you, then you should always use the 2.4 or 8.5 kbps codecs. If you 
are operating over a LAN or WAN, you should try the 8.5 kbps 
codec first, as this will likely give you the best audio performance. 
If you are transmitting over a modem, you should try the 2.4 kbps 
codec first.

4. Select a Default Performance setting. If you are using a 
low-bandwidth audio codec, specifically the Voxware and DigiTalk 
codecs, you can choose between the Standard audio setting and the 
High audio setting. The Standard setting is recommended. It 
provides improved audio when you are conferencing with other 
users of Enhanced CU-SeeMe Version 2.1. The High setting 
provides further audio improvements, but it causes a 2 to 4 second 
delay in your audio; that is, others will hear you 2 to 4 seconds after 
you speak. 

When you are sending audio in a point-to-point connection, 
Enhanced CU-SeeMe will automatically select the best possible 
audio performance setting. 

5. If the audio card in your computer is full-duplex, select the Full 
Duplex checkbox. If you don’t know whether your audio card is 
full-duplex, consult the manufacturer’s documentation.

6. If the Echo Reduction checkbox is selected, then the echo reduction 
slider will be added to the Audio Window (shown in Figure 5-1). 
Echo reduction can be used to eliminate feedback, which can occur 
if your microphone is placed near your speakers. If you are 
receiving audio and sending audio simultaneously, the echo 
reduction control can prevent your microphone from sending the 
sound that is coming from your speakers.

Note:

Voxware and DigiTalk 
audio codecs are not 
available on Macintosh or 
in the Cornell freeware 
version of CU-SeeMe. If 
you use the Voxware or 
DigiTalk audio codecs, 
Macintosh users and 
Cornell freeware users will 
not hear your audio.
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7. Select the Recording Device and the Playback Device. Usually, 

your computer will automatically select the appropriate devices for 
your sound card. If you are unsure about the correct devices, 
consult your sound card documentation.

8. Click OK to confirm your current settings. 
5-7
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New Multicast 
Conference 
Features

Enhanced CU-SeeMe allows you to conference with multiple users 

(Windows users only at this time) in a multicast conference. In a 

multicast conference, you send a stream of video, audio, and conference 

control data over a network to many users simultaneously. Joining a 

multicast conference is similar to connecting to a Reflector. You must 

have Version 2.1 (or later) of Enhanced CU-SeeMe for Windows to 

participate in a multicast conference.

Once the multicast conference has been set up (See “To create a 

multicast conference:” on page 5-11) the conference creator initiates the 

first call to a participant using the Call button in the Phone Book dialog 

box. Any user can join the multicast conference by connecting to the 

conference using the Join Conference dialog box. Users can also join by 

connecting to any participant that has already joined the conference. The 

participants list will not display any participants until a user (in addition 

to the conference creator) connects to the IP address of the multicast 

conference.

Enhanced CU-SeeMe multicast conferences are “loosely coupled” 

which means that participants can join the multicast, or disconnect from 

the multicast at will. Even the creator of the conference can disconnect 

and the conference will continue to exist as long as more than one user 

is still connected to this multicast. When all participants disconnect 

from the multicast conference, then that conference will no longer exist.

Multicast is a special TCP/IP protocol for sending data over an IP 

network from a single source to many recipients. This requires a TCP/IP 

stack that supports multicast. The Microsoft VxD TCP/IP stack, which 

is included with the Windows 95 and Windows NT operating systems, 

supports multicast. The Microsoft TCP/IP stack is available for 

Windows 95 and is included in Windows for Workgroups (3.11). For 

more information on compatible TCP/IP stacks, see the Enhanced CU-

SeeMe Release Notes, which is an online document that was installed 

with your software. 

Important Note:

Multicast is a 
relatively new 
technology. Many 
network interface 
cards, TCP/IP 
stacks, routers, and 
Internet Service 
Providers do NOT 
yet support 
multicast 
conferences. 
Multicast features 
may not work for 
many modem 
users. Please 
consult your 
hardware supplier 
and Internet 
Service Provider to 
find out if they 
support multicast 
conferencing.
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Because multicast is a relatively new TCP/IP protocol, not all routers, 

bridges, and gateways support multicast. Therefore you may not be able 

to multicast over the Internet or over your LAN or WAN. Many modem 

users may find that they are not able to join or create multicast 

conferences. If you want to use multicast over your corporate LAN or 

WAN, check with your Systems Administrator first.

Your ability to participate in a multicast conference also depends on the 

network interface card (commonly called a NIC, or an Ethernet card) 

installed in your computer. For more information on compatible 

network interface cards, see the Enhanced CU-SeeMe Release Notes, 

which is an online document that was installed with your software. 

There are two types of multicast conferences: 

◆ Group Conference - This is an interactive conference where all 

users who are connected can send and receive audio and video, and 

can use the other features of Enhanced CU-SeeMe, such as the Chat 

Window and the WhitePineBoard.

◆ Broadcast - This is a one-way conference where only the 

conference creator can send out video and audio. Others who are 

connected can see and hear the “broadcasted” audio and video, but 

they cannot send audio and video.

Multicast conferences have no limit to the number of participants that 

can join. However, due to bandwidth considerations, a multicast group 

(interactive) conference should generally not exceed100 participants. 

Note that the Participant List can display no more than 32 names at a 

time, regardless of how many people are actually connected to a 

multicast. A multicast broadcast conference (one-way) has no 

limitations as to the number of participants. Multicast broadcast 

conferences will not have a Participant List. However the conference 

creator can see how many participants are viewing the broadcast. 

Before you can create or join a multicast conference, you must be sure 

that your computer is set to enable a multicast.
5-9
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To enable a multicast conference:

1. Select Preferences from the Edit menu or click on the Preferences 
icon in your local video window.

2. Select the Communications preferences group, shown in 
Figure 5-3, by clicking on the Communications tab.

Figure 5-3. Communications Preferences Group

3. Click in the Enable Multicast checkbox to turn this feature on. The 
default setting is to have Enable Multicast turned off. You must 
check this box to create or join a multicast conference. When you 
click on this checkbox, your software will then automatically check 
to see if a TCP/IP stack with multicast support is installed in your 
computer. If this stack is found, then this box will remain checked. 
If an appropriate TCP/IP stack is not found, this box will be empty 
and you will not have the option of creating or joining a multicast 
conference.
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To create a multicast conference:

1. Make sure that multicast is enabled on your computer (See “To 
enable a multicast conference:” on page 5-10).

2. Select Create Multicast Conference from the Conference menu. 
This opens the Create Multicast Conference dialog box, shown in 
Figure 5-4. 

Figure 5-4. Create Multicast Conference Dialog Box

3. Enter a name for your conference in the Conference Name text box. 
The name cannot exceed 31 characters.

4. Select an area from the Area drop-down list box. You can select one 
of five areas. These areas determine how far your multicast will 
reach.

◆ Subnet - Stay within your local area network (LAN). Your 

multicast will not go through routers.

◆ Site - Stay within your Wide Area Network (WAN). For 

example, your multicast may stay within your corporate 

network. This will work only if your WAN has multicast 

routers.

◆ Region - Extend to the Internet for a defined Time to Live 

(TTL) as defined in the Advanced settings dialog box. Your 

multicast will be limited to a defined area on the Internet.

Note:

Before selecting Region, 
Continent, or World as 
your multicast conference 
area, contact your network 
manager to ask whether 
you have the appropriate 
Internet access.
5-11
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◆ Continent - Extend to the Internet for an extended Time to 

Live (TTL) as defined in the Advanced settings dialog box. 

Your multicast will be limited to a defined area on the Internet. 

A Continent will have a greater Time to Live value than a 

Region.

◆ World - Extend to the widest range for a defined Time to Live 

(TTL) as defined in the Advanced settings dialog box. Your 

multicast will be capable of extending globally.

5. Enter a description for your conference in the Description text box. 
This is optional. The description cannot exceed 255 characters. As 
you type, your text will scroll in the text box.

6. Select the conference type.

◆ Group Conference - This is an interactive conference where all 

users who are connected can participate equally.

◆ Broadcast - This is a one-way conference where you can send 

out video and audio. Users who are connected can see and hear 

you, but they cannot send data.

7. Add contact information so that other users can contact you for 
more information about your multicast. This information is optional 
and can include the following:

◆ URL - You can enter a URL for a Web site that could include 

information about your multicast conference. Participants who 

join this conference can then automatically open their Web 

browsers to get this information. 

◆ Email Address - Include your Email address if you want people 

to contact you via Email.

◆ Phone Number - Include your phone number if you want 

people to contact you via the telephone. Remember to include 

your complete phone number because participants in your 

conference could be located anywhere in the world.

For most users, these settings are all that you will need to set up a 

multicast conference. For more advanced users, Enhanced CU-SeeMe 

offers the option of further customizing the parameters of the multicast 

conference.
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To enter advanced settings for a multicast conference:

1. Click on the More button in the Create Multicast Conference dialog 
box (see Figure 5-4). This expands the dialog box to offer further 
customizing options, shown in Figure 5-5. To shrink the dialog box 
back to its original size, click on the Less button.

Figure 5-5. Advanced Multicast Conference Settings

2. Enter a conference password in the Conference Password text box. 
This is optional. If you enter a password, then other users must type 
this password in order to connect to your multicast conference. 
Passwords are case-sensitive and the password cannot exceed 31 
alphanumeric characters.

3. Enter a conference ID in the Conference ID text box. This is 
optional. If you enter a conference ID, then other users must type 
this ID in order to participate in your multicast conference. 
5-13
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4. Enter a Time to Live (TTL) value. The TTL determines how far 

your multicast conference will be transmitted on subnets. The TTL 
value defines the number of routers through which your signal will 
pass. The maximum TTL value is 225, meaning that your signal 
will pass through 225 routers. (Note: Subnets can be accessed only 
if the routers connecting the subnets support IP multicast.) This 
number is automatically assigned to your area, however you can 
modify it.

5. In the Audio/Control Multicast Address portion of the dialog box, 
find the checkbox titled Use Default Settings. By default, this is 
checked. If you uncheck this box, you will see additional text boxes 
which may be filled in. These are described in the following steps.

6. Find the checkbox titled All Video Streams On This Address. By 
default, this is checked. This means that every video user connected 
to your multicast conference will send video data on the same video 
IP address. This is required for most TCP/IP stacks and network 
interface cards.

7. Assign a Video IP Address. This IP address and port are 
automatically assigned once your multicast conference begins, 
however you can modify it if you unchecked the box titled Use 
Default Settings.

8. Assign an Audio/Control IP Address. This IP address and port are 
also automatically assigned once your multicast conference begins, 
however you can modify it if you unchecked the box titled Use 
Default Settings.

9. Assign a Port number. You can have multiple ports within an IP 
address. The default Port number for Enhanced CU-SeeMe is 
automatically assigned. You will probably not want to change this 
value unless you know a specific multicast port number that you 
want to use.

Congratulations! You are now connected to a multicast IP address. You 

can get the conference underway by calling a participant using the Call 

button in the Phone Book dialog box.

Any user can join your multicast conference by connecting to the 

conference using the Join Conference dialog box (See “To join a 

multicast conference:” on page 5-15), or by connecting to any 

participant that has already joined the conference. The participants list 

will display all participants that are connected to the IP address of the 

multicast conference (up to a maximum of 32 users).

Note:

Before modifying the TTL 
value, contact your 
network manager to ask 
whether you have the 
appropriate multicast 
router support.
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To join a multicast conference:

1. Make sure that multicast is enabled on your computer (See “To 
enable a multicast conference:” on page 5-10).

2. Select Join Multicast Conference from the Conference menu. This 
opens the Join Multicast Conference dialog box, shown in 
Figure 5-6.

Figure 5-6. Join Conference Dialog Box

3. Select a conference from the list in the Active Group Conferences 
box.
5-15
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4. When you select a conference from the list provided, you will see 

the information about that conference in the following text boxes: 

◆ Conference Area - Subnet, Site, Region, Continent, or 

Unrestricted

◆ Conference Type - Group or Broadcast

◆ Description - Information provided by the creator of the 

conference

5. Using the checkboxes, select whether you want to Send Video and 
Receive Video in this multicast conference. By default, these are 
both checked.

6. If the conference is password protected, you will be prompted to 
enter the password in the Conference Password text box.

7. If the conference creator provided additional contact information, 
you will see this in the lower portion of this dialog box. If there is a 
URL associated with this conference, then you can automatically 
launch your Web browser and connect to that URL by checking the 
box titled Launch Browser with Conference URL. This URL may 
be used to provide information about the multicast conference.

8. Click on Join to join the multicast conference.

Congratulations! You have now joined a multicast conference. This 

multicast conference should appear the same as a conference on a 

Reflector. You can use all the same features, such as the chat window, 

participant list, and WhitePineBoard.
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Locating Other 
Users Online

There are many users of Enhanced CU-SeeMe around the world. You 

may want to find out who they are and how to contact them. White Pine 

has made this easy. White Pine has collaborated with Four11 

Corporation to provide a Web-based directory services which will 

enable you to easily find other users of Enhanced CU-SeeMe, see if they 

are online, and make a direct videoconference connection to them. 

When you installed Enhanced CU-SeeMe on your computer, you were 

presented with an opportunity to register yourself in the directory 

services. If you chose this registration option, you are now listed in this 

directory and other users will be able to see when you are online using 

Enhanced CU-SeeMe. They can then choose to call you directly. You 

will also be able to locate other registered users.

Many Internet users have an Internet Service Provider, or an online 

service, that assigns them a new IP address each time they connect to the 

Internet. This has made it difficult for users to call each other directly. It 

is like having a new phone number assigned to you each time you pick 

up your phone. The Web-based directory services solves this problem by 

automatically registering your current IP address the moment you go 

online, making it easy for people to locate each other online.

For your convenience, you can access the directory services in either of 

the following ways:

◆ Double-click on the Four11 icon in the CU-SeeMe program group.

◆ Click the Directory Services button in the Phone Book, as shown in 

Figure 5-7.
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Figure 5-7. Phone Book 

Either of these methods will launch your default Web browser (if one is 

installed) and connect you to the directory services search page. You can 

then enter the name of the person you want to look up, and click on the 

Search button. You can also choose to leave all the fields blank and click 

on the Search button for a list of registered CU-SeeMe users.

Registering Yourself in Directory Services

All users of Enhanced CU-SeeMe, Windows and Macintosh users alike, 

can register themselves in the Web-based directory service, enabling 

other users to locate them online. However, only users of Enhanced 

CU-SeeMe Version 2.1 for Windows can currently connect directly to 

the Web-based directory service from their Enhanced CU-SeeMe 

application, and can launch Enhanced CU-SeeMe from the directory. 

Macintosh users can look forward to these features in a future release.
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You can register in any of the following ways:

◆ Choose the registration option when you install Enhanced 

CU-SeeMe on your computer.

◆ Double-Click on the Registration icon in the CU-SeeMe program 

group.

◆ Go directly to Four11’ s home page on the Web at: 

http://www.four11.com/

You can use the Web-based directory service to search for other users of 

Enhanced CU-SeeMe. Then you can find out whether or not they are 

currently online, and you can automatically launch a connection to 

them. Even if you are not registered, you can still search for other users. 

When you do register, you allow other people to find you, check 

whether or not you are online, and let them connect directly to you. 

Configuring Your Web Browser

If you want to use the directory service to directly connect to another 

user, you will need to tell your Web browser how to launch Enhanced 

CU-SeeMe. To do this, you need to define the Enhanced CU-SeeMe 

application as a helper application in your Web browser.

To set up your browser to automatically launch Enhanced 
CU-SeeMe:

1. Locate the dialog box that allows you to add new file types in your 
browser, typically in a preferences dialog box. For example, in 
Netscape™, choose General Preferences (Windows) or Preferences 
(Macintosh) from the Options menu, then select Helper 
Applications. In Microsoft Internet Explorer, Choose Options from 
the View menu, then select the File Types tab.

2. Click the Create New Type button (Windows) or 
New button (Macintosh). 

3. Specify the Mime type: application

4. Specify the Mime subtype: x-cuseeme
5-19
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5. Specify the file extensions: cu, csm

6. Specify Enhanced CU-SeeMe as the application.

7. In Windows you need to make sure Enhanced CU-SeeMe is in your 
path, or specify the full pathname for the cuseeme executable file.

8. Set the action to launch the application in Netscape, or open the 
application in Internet Explorer.
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Tuning Your 
Video 
Performance

You may wish to adjust your settings to improve the video image you 

transmit. Many of the default video settings in Enhanced CU-SeeMe can 

be changed using the Preferences dialog box. 

To change a video preference setting:

1. Select Preferences from the Edit menu or click on the Preferences 
icon in your local video window.

2. Select the Video preferences group by clicking on the Video tab 
(Windows) or selecting the Audio/Video group name from the 
pop-up menu (Macintosh).

Configuring the WhitePine Color Video Codec
If you have selected the WhitePine Color video codec from the Video 

preference group, click on the Configure button to make additional 

adjustments. The Configure dialog box will appear, as shown in 

Figure 5-8.

Figure 5-8. Configure Dialog Box
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Use this dialog box to configure the WhitePine Color codec. A codec is 

software that compresses and decompresses your video (or audio) data 

so that it can transmit more easily across phone lines or a network. The 

specific features of the WhitePine Color codec are described below. If 

you wish to change the appearance of the video you send, a good 

general rule is to modify the values of the codec in this dialog and see 

how those changes affect the performance of your remote video when 

you connect to Self.

Smeared “I” Frame Rate
Your video data is transmitted as a series of frames, which are updated 

continuously. In order to get the smoothest possible video with the least 

amount of data loss, the video codec looks at the changes from one 

video frame to the next, compresses this changed data, and then adds 

this data to the previous frame. The result is that the video image you 

transmit is updated as you move in front of your camera. Unfortunately, 

there is usually some unavoidable loss of data as your video image is 

sent across a network. To compensate for this loss and to make sure 

unwanted “noise” won't build up on the connection, a full frame 

(containing ten times more data than a typical frame which only 

includes the changes since the previous frame) is periodically 

distributed (or “smeared”) over a number of frames. This number of 

frames is specified by the Smeared “I” Frame Rate. The Smeared “I” 

Frame Rate determines the timing of this insertion. A lower number 

means that this full frame is inserted more often.

The default Smeared “I” Frame Rate is 45, which takes into account the 

amount of noise on a typical Internet connection. For connections over a 

LAN, where there is much less noise, the rate of insertion can be 

increased, which means changing the setting to a lower number.
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Gamma Correction Factor
The Gamma Correction Factor is similar to the brightness control on a 

television set. On the Gamma Correction Factor scale, the higher the 

number, the brighter the picture.

The default setting is 33, which means there is no Gamma Correction. 

The Gamma Correction affects only the video windows that you see on 

your computer monitor. It does not affect the video that you transmit to 

others.

Apply Noise Reduction Filter
The hardware components of some low-end cameras generate a lot of 

static noise, which is difficult to compress. When the Apply Noise 

Reduction Filter box is checked, an extra operation is added in which 

noise is filtered before going through the codec (COmpression-

DECompression) process. The result is a picture that is received with 

less noise. The picture will also use less bandwidth if the noise is filtered 

out. Note that this filter will only affect how other users see your video 

image. Using this filter uses some CPU power from your computer, but 

it can be helpful to clean up the image sent by your camera.

Lossless Options
The term lossless means a perfect replication of a picture so that the 

picture, after it has been compressed and decompressed, is exactly the 

same as it was before entering this process. That is, no quality is lost in 

the picture. 

There are three lossless options:

◆ Luminance - preserves brightness and contrast

◆ Chrominance - preserves color

◆ Quality - preserves clarity (no blurring)
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You can transmit in high quality lossless mode by checking these 

options and setting Quality to100% (on the Video preferences tab). 

Check Lossless Luminance to transmit lossless grayscale; check both 

Lossless Luminance and Lossless Chroma for color. 

Achieving this high quality mode is expensive in terms of the amount of 

bandwidth used. A perfect picture replication is possible, but it can 

reduce your frame rate. The default for both options is to be turned off.

ME Search Radius
Use the ME (Motion Estimator) Search Radius to establish the 

neighborhood in which the WhitePine Color codec's Motion Estimator 

compares motion between one video frame and the next. The Motion 

Estimator looks in a search radius (or neighborhood) of X pixels of the 

video subject, where X is the number of pixels entered in the ME Search 

Radius box. The default is 8 pixels.

If there is going to be a lot of motion in your video, a wider radius 

means a smoother picture. This uses less bandwidth, however, it can be 

expensive in terms of the amount of CPU used.

Bit Stream Data
The default transmission mode for the WhitePine Color codec is, 

appropriately, color. You can, however, choose to use the WhitePine 

Color codec but transmit in gray images by clicking on the Gray Scale 

radio button in this dialog box. Typically, removing the color 

information from the bit stream in this way results in a 10%-20% 

reduction in the bandwidth requirements.
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Frequently 
Asked 
Questions

White Pine maintains a list of Frequently Asked Questions (commonly 

referred to as FAQs) on the World Wide Web.

To reach the White Pine FAQ Web page, use the following URL:

http://www.cu-seeme.com
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Technical Support
Technical 
Support Policy

White Pine Software provides telephone support to all Registered users 

after registering the product. Only purchased copies of the product can 

be registered, meaning that you can not register any of the freeware 

versions available through Cornell University. 

You can contact technical support using the conventional methods listed 

in “Contacting White Pine Software” on page A-8 or you can get 

technical support through the White Pine Software Web pages.

World Wide Web Technical Support
The White Pine Software World Wide Web pages offer a variety of 

information about our company, our products, and demo versions of our 

released software, in addition to technical support.

The Technical Support pages offer online registration, technical support 

through an interactive form, and a list of Frequently Asked Questions 

about using Enhanced CU-SeeMe on both the Windows and Macintosh 

platforms.

To reach the White Pine Software technical support’s Web page, use the 

following URL:

http://www.cu-seeme.com

E-Mail Support
The White Pine Software technical support staff also answers questions 

through e-mail. It is important that you provide all the information listed 

in “Before Contacting Technical Support” on page A-4, in addition to 

the following information:

◆ your name

◆ company name

◆ phone number

This information is necessary for contacting you directly, if required.
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Before 
Contacting 
Technical 
Support

White Pine Software provides technical support to registered users. 

Return your user registration card promptly or register Enhanced 

CU-SeeMe using on-line registration (see “World Wide Web Technical 

Support” on page A-3). Product registration guarantees you new 

product notification and product upgrades.

To get your problems solved as quickly as possible, the technical 

support staff requires as much pertinent information as possible. If you 

can supply us with this information at the time of your call, we can 

understand and resolve your problem much faster. You should have this 

information ready and be at your computer when you call for technical 

support and be ready to reproduce the problem while talking to a 

technical support staff member.

Please fill out the following information before calling:

Serial #:

Product:

Version:

Date Purchased:

Original Purchaser:
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PC Configuration
Make and Model: 

DOS Type and Version: 

Microsoft Windows Version: 

Disk Space: 

Memory (RAM): 

Video Card Manufacturer and Model: 

Video Capture Card Manufacturer and Model: 

Sound Card Manufacturer and Model: 

Camera Manufacturer and Model: 

Microphone Manufacturer and Model: 

Contents of the following files:

◆ Network configuration files, if applicable 

(for example, TCP.CFG or NET.CFG)

◆ WIN.INI

◆ SYSTEM.INI

◆ CUSEEME.INI

◆ AUTOEXEC.BAT

◆ CONFIG.SYS
A-5
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Macintosh Configuration
Model:

System Version:

Finder Version:

Memory (RAM):

AV Card: 

VRam: 

Camera Manufacturer and Model: 

Microphone Manufacturer and Model: 

Digitizer Manufacturer and Model: 
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Communications Configuration
Internet Connection:

Ethernet:        ISDN:         Modem:

Modem Manufacturer and Model:

Model of your Ethernet board:

Network drivers and other communication software installed on your 

system:

     TCP/IP Driver:

      Dial-up (if using a modem) PPP/SLIP:

Open Transport version (Macintosh): 

Internet Service Provider (ISP):  
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Contacting 
White Pine 
Software

While our Technical Support staff often takes calls immediately, there 

are times when a representative may be unavailable. If your problem can 

not be resolved during your initial call, the issue will be discussed with 

our product specialists and engineering staff and the representative will 

contact you to keep you informed of the status of the situation.

Support Phone
603-594-2804 8:00 am - 8:00 pm EST

408-446-9203 8:00 am - 8:00 pm PST (available after 10/7/96)

Fax
603-886-9051

Internet
E-Mail: support@cu-seeme.com

WWW: http://www.cu-seeme.com

Sales Hot Line
For more information about all White Pine Software products, please 

contact the White Pine Software sales department. Demos and product 

information are also available on the World Wide Web. 

U.S. E-Mail: info@wpine.com

U.S. Phone: 1-800-241-PINE (7463)

Europe E-Mail: euro_info@wpine.com

Europe Phone: +33 93 24 76 00

WWW: http://www.cu-seeme.com
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Glossary
Audio Window The  window that allows you to manage sound coming into and going 

out of your system.

Bandwidth The capacity a connection has to send information. It is usually 

measured in bits per second (bps).

Broadcast The transmission of the same data to a selected group of destinations.

Browser A software program that allows a user to access resources on the 

Internet.

Chat Window A feature of Enhanced CU-SeeMe that allows users to converse using 

text messages.

Codec COmpressor/DECompressor; Hardware or software that compresses 

audio and video data.

Conference Administrator The person responsible for setting up and monitoring the reflector.

Conference ID A number between 1 and 32768 that is provided to attendees of a private 

conference session. This ID number is needed to log into your server.
G-1
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Data Compression A technique that systems use to save bandwidth by eliminating empty 

fields, gap redundancies, and unnecessary data to reduce the size and 

length of the records being sent.

Enhanced CU-SeeMe Desktop video/audio conferencing software for both Macintosh and 

Windows computers. 

Full-Duplex Allows both parties to send and receive audio at the same time. This 

only affects the receiver.

Half-Duplex Allows only one person to talk at a time. This affects the receiver only.

Internet A global network that uses the TCP/IP protocol.

Internet Service 
Provider

A company that provides a connection to the Internet for a fee.

IP Address The unique numeric address for every computer that is connected to the 

Internet. It has four sections separated by a dot, for example, 100.1.1.1. 

An IP address can be dynamic and is often provided by Internet service 

providers.

IP Name The unique name for every computer that is connected to the Internet. 

ISDN Integrated Services Digital Network; A high bandwidth network used to 

move large amounts of data over phone lines.

kbps kilobits per second

Listener An Enhanced CU-SeeMe feature that alerts you to an incoming call.

Local Area Network 
(LAN)

A network made up of two or more computers connected together. They 

are usually within the same building or within a very short distance (a 

mile or less) to each other.

Local Video Window The window containing your video that appears when you start up 

Enhanced CU-SeeMe.

Message of the Day 
(MOTD)

A dialog box that appears when users access Enhanced CU-SeeMe. It 

can provide information about the reflector, current and upcoming 

broadcasts, etc.
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Multicast The ability to send one stream of video data and one stream of audio 

data over a network, and many users can simultaneously connect to and 

receive these streams of data without the use of a Reflector. 

Netiquette Network etiquette; Using “good netiquette” allows faster and better 

conferences.

Participant List A window containing the list of visible users, hidden users, and lurkers 

connected to a conference.

Phone Book An Enhanced CU-SeeMe feature that works just like a hard copy phone/

address book. It allows you to keep track of nicknames and IP 

addresses.

Point-to-Point 
Connection

A connection between two users without the use of a reflector.

PPP Point-to-Point Protocol; A protocol that allows a computer to make a 

TCP/IP connection using a telephone line and a modem.

Protocol Allows programs on different computers to communicate.

Reflector A UNIX or Windows-based software program that allows multiple users 

to view and send video and audio streams.

Remote Video Window The window that contains the video sent by another participant in the 

conference.

Router A computer system or software package that connects two or more 

networks. Routers look at the destination addresses of the IP packets 

and forward them to the correct address.

SLIP Serial Line Interface Protocol; A protocol that allows a computer to 

make a TCP/IP connection to the Internet using a telephone line and a 

modem.

TCP/IP Transmission Control Protocol/Internet Protocol; The protocol that 

defines the Internet.

Time-to-Live TTL - A value used by routers that is decremented as it is passed from 

router to router.

URL Uniform Resource Locator - An “address” used to locate information on 

the Internet.
G-3
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Videoconferencing Software and hardware that allows users to see and hear each other 

using their computer systems.

WhitePineBoard A feature of Enhanced CU-SeeMe that allows users to view, create and/

or share the same document at the same time.

Wide Area Network 
(WAN)

A large network made of connected LANsw.
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White Pine Software, Inc.
Electronic End User License Agreement

THIS IS A CONTRACT. BY INSTALLING THIS SOFTWARE YOU ACCEPT ALL THE 
TERMS AND CONDITIONS OF THIS AGREEMENT.

This White Pine Software, Inc. (“White Pine”) End User License Agreement accompanies a 
White Pine software product and related explanatory written materials (“Software”). The term 
“Software” shall also include any upgrades, modified versions or updates of the Software 
licensed to you by White Pine. 

1. White Pine grants to you a non-exclusive, non-sublicensable, license to use this Software in 
binary executable form.

YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE PROGRAM OR 
DOCUMENTATION, OR ANY COPY EXCEPT AS EXPRESSLY PROVIDED IN THIS 
AGREEMENT.

2. White Pine reserves the right at any time not to alter prices, features, specifications, 
capabilities, functions, licensing terms, release dates, general availability or other characteristics 
of the commercial release of the software.

3. Title, ownership rights, and intellectual property rights in and to the Software shall remain in 
White Pine and/or its suppliers. You agree to abide by the copyright law and all other applicable 
laws of the United States including, but not limited to, export control laws. You acknowledge 
that the Software in source code form remains a confidential trade secret of White Pine and/or its 
suppliers and therefore you agree not to modify the Software or attempt to decipher, decompile, 
disassemble or reverse engineer the Software, except to the extent applicable laws specifically 
prohibit such restriction.

4. Copyright. The Software is owned by White Pine and its suppliers, and its structure, 
organization and code are the valuable trade secrets of White Pine and its suppliers. The 
Software is also protected by United States Copyright Law and International Treaty provisions. 
You agree not to modify, adapt, translate, reverse engineer, decompile, disassemble or otherwise 
attempt to discover the source code of the Software. You may use trademarks only to identify 
printed output produced by the Software, in accordance with accepted trademark practice, 
including identification of trademark owner's name. Such use of any trademark does not give 
you any rights of ownership in that trademark. Except as stated above, this Agreement does not 
grant you any intellectual property rights in the Software.

5. White Pine may terminate this License at any time by delivering notice to you and you may 
terminate this License at any time by destroying or erasing your copy of the Software. In the 
event of termination, the following sections of this License will survive: 2, 3, 4, 5, and 6. This 
License is personal to you and you agree not to assign your rights herein. This License shall be 
governed by and construed in accordance with the laws of the State of New Hampshire and, as 
to matters affecting copyrights, trademarks and patents, by U.S. federal law. This License sets 
forth the entire agreement between you and White Pine.



6. WHITE PINE OR ITS SUPPLIERS SHALL NOT BE LIABLE FOR (a) INCIDENTAL, 
CONSEQUENTIAL, SPECIAL OR INDIRECT DAMAGES OF ANY SORT, WHETHER 
ARISING IN TORT, CONTRACT OR OTHERWISE, EVEN IF WHITE PINE HAS BEEN 
INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR (b) FOR ANY CLAIM BY 
ANY OTHER PARTY. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO 
LIABILITY FOR DEATH OR PERSONAL INJURY TO THE EXTENT APPLICABLE LAW 
PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME STATES DO NOT ALLOW 
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THIS LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU.

7. ACKNOWLEDGEMENT: YOU ACKNOWLEDGE THAT YOU HAVE READ THIS 
AGREEMENT, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND 
EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND 
SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, 
AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE 
SUBJECT MATTER OF THIS AGREEMENT.

Should you have any questions concerning this Agreement, please contact in writing:
White Pine Software, Inc., 542 Amherst Street, Nashua, NH 03063.
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